u-center

GNSS evaluation software for Windows
User Guide

Abstract

This document leads you through the efficient use of the u-center
evaluation software, the powerful and easy to use tool from u-blox
for evaluating, performance analysis and configuration of u-blox
GNSS positioning chips and modules.
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Preface

Overview

u-center is u-blox’ powerful GNSS evaluation and visualization tool which can be downloaded free-of-charge
from our website (www.u-blox.com). This user guide provides a description of the features of this software. It
allows end users to assess and test u-blox GNSS positioning chips and modules for navigation and positioning
performance.

The purpose of u-center is to enable users to:
Conduct performance tests on u-blox and other GNSS devices.
Configure u-blox GNSS positioning chips and modules.
Update the firmware on GNSS modules.
Test the added performance provided by u-blox” AssistNow service.

Using this guide

This guide assumes that the user has basic computer skills and is familiar with the Windows Graphical User
Interface (GUI) and GNSS receiver environments.

The following symbols are used to highlight important information:

& An index finger points out key information pertaining to integration and performance.

& A warning symbol indicates actions that could negatively impact or damage the receiver.

Technical support

If you have questions about installing or using u-center:
Read this user guide carefully.

Check our homepage (http://www.u-blox.com) to ensure that your GNSS device, firmware and the u-center
software are the latest versions.

Refer to our web based information service.

Worldwide Web

Our website (www.u-blox.com) is a rich pool of information. Product information and technical documents can
be accessed 24/7.

By email
If you have technical problems or cannot find the required information in the provided documents, contact the

closest technical support office. To ensure that we process your request as soon as possible, use our service pool
email addresses rather than personal staff email addresses. Contact details are at the end of the document.

Helpful information when contacting technical support

When contacting technical support, have the following information ready:
Receiver type (e.g. NEO-7N), firmware version (e.g. 1.00), and u-center release (e.g. u-center 8.00)
Receiver configuration and short description of the application
Your complete contact details

UBX-13005250 - RO6 Production Information Preface
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1 Features

u-center evaluation software provides system integrators and end users with a quick and simple way to interface
with u-blox GNSS chipsets, modules and boards. It enables easy evaluation, performance testing, development
and debugging of GNSS positioning chips and modules. u-center allows easy connection to u-blox products and
provides a suite of features to view, log, and analyze performance. The features include:

Support for u-blox’ receivers using u-blox positioning technology. u-center can communicate with these
receivers using either the UBX protocol or the NMEA-0183 standard protocol.

Support for receivers that utilize standard NMEA strings.

u-center presents all the information collected during the operation of the GNSS device. All aspects of GNSS
data (position, velocity, time, satellite tracking, etc.) can be monitored and logged under various test
scenarios for the evaluation of a receiver. u-center software allows analysis of the collected data in order to
investigate performance issues such as accuracy, road test position and trajectory, satellite tracking, time to
first fix, etc. All processed data can be captured in ASCIlI format and ported into popular spreadsheets for
creating additional plots and statistics.

Camera View: photographic data can be stored in the log file together with the navigation data and later be
replayed in the application.

Export data files to Google Earth and Google Maps.

Supports (Multiple GNSS) AssistNow Online and AssistNow Offline.
Data recording and playback function.

Structural and graphical data visualization in real-time.

Export functionality to standard PC applications.

Docking views (real-time cockpit instruments):
Satellite constellation, compass, clock, altimeter, speedometer, GNSS and satellite information views.

Download firmware updates to GNSS positioning modules.

UBX-13005250 - RO6 Production Information Features
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2 Getting started

2.1 General information about displayed values

Longitude and latitude are displayed according to the datum selected in the GNSS device (usually: WGS-84).
This option can be polled and set using the UBX-CFG-DAT message.

Time is displayed with reference to UTC

Elevation is displayed with reference to either MSL (Height above mean sea level or Orthometric Height) or
to HAE (Height above WGS-84-Ellipsoid). The reference is controlled by the GNSS configuration.

2.2 Connecting an u-blox evaluation kit to the PC

This section assumes that you have purchased an u-blox evaluation kit. Should you try to connect a different
GNSS device to the PC, make sure you use appropriate RS-232 level shifters.

The evaluation kit can be connected to the PC by using either an USB or a serial cable. In case of using the USB
port, a driver is required (contained in the u-center installer or downloadable from our homepage). Be sure to
install the driver before connecting the evaluation kit to the computer.

2.3 Installing u-center

The installation program guides you through the necessary steps for a successful program installation. During the
installation, you can choose the destination folder for the program.

& u-center uses dynamic link libraries (DLL). The installation program will automatically install the
required DLL's into the u-center program directory. Should you try to copy a u-center
installation from one location to another after the installation, make sure you copy the DLL files
as well.

After a successful installation, u-center can be started from the Start Menu (All Programs -> u-blox -> u-center ->
u-center) and will start up as shown in:

@ uecenter 801 [PE———
File Edn View Flayer Recener Tools Window Help -

DH& - & AaaEonoDoO-cE-E-M-BF Ao ce0aan

O v v | 2 - - v L | i

@blox u-center

| locate, communicate, accelerate

www.u-blox.com

eady @6 Ho port open u-blax 3

Figure 1: Start display

UBX-13005250 - RO6 Production Information Getting started
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2.4 Connect to the receiver

2.4.1 Select the port

Locate the communication toolbar (Figure 2) and click on the arrow beside the s icon. This will show a list with
all available COM ports (Figure 3). Select the corresponding COM port where the receiver is connected. If a link
could be established, the icon will turn green =m= and the text in the status bar changes from €% Disconnected

to =®= COM& 9600 (in this example u-center is connected to COMS6). This does not mean that the
communication already works but only that the port could be opened.

AE v U » | 75

Figure 2: Communication toolbar

A6« U * | 5
*  [isconnect

COomnl
COmM4
COMS
COMEB
COM7

Figure 3: List of available COM ports

2.4.2 Select the baud rate (only for COM ports)

Again in the communication toolbar, click on the arrow beside the nnricon. This will show a list with all available
baud rates (Figure 4). Select the correct baud rate on which the receiver is communicating (typically 9’600 baud).
If u-center is able to decode data from the receiver, the status bar begins to blink in green as shown in the
following icon: == COMBS9800  This means that the connection is established successfully and the
communication between the receiver and u-center is working.

= v 0| |

1'200
2'400
4'300

*  0'B00
19°200
38'400
57600
115°200
230400
460800
921600

Figure 4: List of available baud rates

You are now ready to use the receiver.

UBX-13005250 - RO6 Production Information Getting started
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3 Concept and philosophy

Understanding the basic concept behind u-center is important in order to get the highest benefit out of this
powerful evaluation software. Figure 5 depicts the architecture of the software. The program gets a data stream
from either a COM port or a log file and splits this stream into protocol messages. From the messages, relevant
parameters are extracted and inserted into the current dataset of the database.

In the current dataset, statistical values of the parameters are calculated. Average, Minimum, Maximum and
Standard Deviation are calculated for most parameters. If a protocol does not provide a parameter, u-center tries
to calculate the parameter from the ones that are available. For example if velocity-north and velocity-east are
available, u-center calculates the speed over ground and course over ground, unless this data is already available
in the protocol.

Map Views
Table Views
Docking Views
Statistic Views
Graphical Views
Histogram Views

Calculate
Parameters
from other
Parameters

Protocol

Message Parameter —
o Extracter :
Parser R

Data
Source

©

Logfile.ubx

Calculate
Statistics

Package Views
Console Views
Message Views

—lp Data stream

——p Messages

——p Parameters

v

Figure 5: Engine Architecture

When a new epoch (change in time) is detected, the current dataset is stored as history in the database. This
history has a limited size. If the size is exceeded u-center keeps only the latest datasets and the oldest ones are
removed. The history size may be adjusted. Refer to section 3.3 for the details

u-center provides various view classes for observation. Most views take their data from the database, but some

get their data directly from the message without using the database at all. The other views are updated when
the database changes.

Message Views Displays and decodes a copy of every known message. This view allows observing a single
message in detail and it may also be used to configure the GNSS device. Refer to Section 4.2.4 for details.
The configuration view is a subset of the message view and only displays message to configure the receiver.

UBX-13005250 - R0O6 Production Information Concept and philosophy
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&

Console Views Displays the messages in text form. They are particularly useful for users to develop GNSS
firmware code. There is also a wide range of information available which is useful for evaluation and testing.
Refer to sections 4.2.1, 4.2.2 and 4.2.3 for details.

Graphical Views Displays parameters from the database in graphical form. Charts (see section 4.2.9),
Histograms (section 4.2.10) and a Map Overlay (section 4.2.8) can be created. There are two more views
(Deviation View and Sky View, see sections 4.2.12 and 4.2.13) that may be used for statistical performance
and antenna pattern analysis.

Tabular Views Shows the parameters of the database in tabular form. They can be freely configured to
allow customized tables. Refer to sections 4.2.5 and 4.2.6 for details.

Docking Windows Can be docked to the frame of u-center. An analog watch, compass, world map,
altitude and speed meter are available. There are also docking windows showing the current signal power
and the constellation of the satellites received by the device as well as a summary of the GNSS status.

Displaying various views and docking windows requires computing power. Minimizing or closing them
may significantly reduce CPU usage.

3.1 Color and satellite coding scheme

In the graphical views and some docking windows, colors are used to indicate data quality. Table 1 shows the
color codes for graphical views depending on the quality of the navigation solution.

Color Meaning
Yellow Current value
Orange Valid 3D navigation fix + Dead Reckoning
Green Valid 3D navigation fix
Cyan Valid 2D navigation fix

-4  Magenta Dead Reckoning Fix

4 Blue Degraded navigation fix

4 Red No or invalid navigation fix

Table 1: Color-coding scheme for graphical views

UBX-13005250 - R0O6 Production Information Concept and philosophy
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Table 2 gives the color-coding scheme for the Docking Windows and Sky View. It indicates the state of each
satellite.

Color Meaning

‘@  Green Satellite used in navigation (with Ephemeris)

‘@ Ol Satellite used in navigation (with Ephemeris and PPP)

|_.+ Dark Green Satellite used in navigation (with aiding data: AssistNow Autonomous,
AssistNow Online/Offline)

‘@ Cyan Satellite signal available, available for use in navigation

@ Blue Satellite signal available, not available for use in navigation

@ Red Satellite signal not available

Table 2: Color-coding scheme for the docking windows and sky view

Table 3 gives the satellite-coding scheme for the docking windows and sky view.

Satellite Code System
Gxx GPS

RXX GLONASS
Bxx BeiDou
Exx Galileo
Sxx SBAS

QXX QZSS

Table 3: Satellite-coding scheme for the docking windows and sky view

Figure 6 shows the color legend. This is available under: Tools - Preferences - Status Colors.

x

Genericl W’ork&pacel Colars { =]

| Messagebox I

Mavigation Fis Status

Ma / lrvalid I + LtRed vI Valid 20 I LlE_l,lan vl
Degraded I &= LtBlue vI Walid 30 I LtGreen vl
Dead Reckon I &4 Magenta vI Walid 3D+DR I LtOrange vl
Current I L ellome x l

Satellite Status

Mo Signal I@ Fed vI Used Iﬁ} Green vl
Signal I@ Elue vI Uzed [FPF] I(ﬁ} Custom... "I
Ready I@ Cyan vI Used [no Eph]lﬁ} DkGreen 'I

0K I Cancel | Spply |

Figure 6: Color-coding scheme for graphical views, docking windows, and sky view

UBX-13005250 - R0O6 Production Information Concept and philosophy
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3.2 Operating modes

u-center has different operating modes (see Figure 7). The mode changes when you open or close a log file or
when you make an action in the player. To be able to use the record mode you have to create a new file, save to
a new file or open an existing file. The record and player mode are only available if you have created a new file
or when you have opened a write-able file.

Recorder
Mode

Open/Create File

Close/Eject File

Figure 7: Relations between operating modes

3.2.1 Online mode

In this mode a GNSS device is directly connected to u-center via a COM port. u-center can control and configure
the receiver and it will display the data that the receiver is sending periodically.

3.2.2 Stop mode

In this mode no data from a receiver or a log file is forwarded to the database and views. u-center is in this
mode when a log file is open but player and recorder are not active.

3.2.3 Recorder mode

Recorder Mode is the same mode as the Online Mode, except u-center additionally creates a log file,
concatenating all the messages sent by the receiver. You enter this mode by creating a new log file or opening
an existing log file without write protection and pressing the record button. An example of using this mode
would be to make overnight measurements and evaluate the data at a later time. u-blox customer support may
request a log file from you when you are experiencing a problem with one of our receivers.

UBX-13005250 - R0O6 Production Information Concept and philosophy
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3.2.4 Player mode

The Player Mode allows replaying a previously recorded log file step by step, in real-time or at an accelerated
rate. You enter this mode by opening a file and pressing the play, step or scan button.

3.2.5 Relations between modes

The operating mode depends on the status of the log file player. Modes are changed by user actions. Each mode
has different states that are changed by a user action or by an event (see Figure 7).

In Online and Recorder modes, u-center displays data from the receiver. In Player mode data from a log file is
displayed. Player mode has different states. In Play state messages are read and displayed periodically from the
log file. The very intuitive user interface is derived from that of a CD player. u-center updates the views after
each message. Step state only gets one message from the log file and immediately returns to paused Play state.
Scan state also reads messages periodically but the display is only updated when paused or by changing the
state. Position can be set in a log file. This behaves differently in the Player and Stop modes. In Stop mode the
position is just set and no data is read and displayed. u-center will start recording or playing from that position
when changing the mode. If position is set in Player mode, u-center will load the data up to this position from
the log file and display the contents.

3.3 Database limitation

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of large log files. The
limit is set to 1800 epochs by default. This means if an epoch is available every second you can analyze data for
up to 30 minutes. After this time the oldest values are discarded. Data stored to a log file is not affected by the
database limitation.

Preferences |
Generic | Workspace ] Colors ] Status Colors] Messagebm(]
Serial ports
Iv¥ Automatically (disjconnect f most recently used serial port (disfappears.
Enumerate seral ports using ‘CreateFiIe j
Maxdmum number of serial ports ZSSA l
Power Management
&+ MNone @ " Disconnect on suspend
Program Options {requires restart) MNmea Custom BDS Talker Id
& COMS - u-center 8.01 |
File Edit View Player Receiver Window Help
O~ Firmware Update Antaris ... =
= o i || % % II;irrnwaRre U?dat;.u-b\Dx:a'ﬁﬂfMS..‘ I Database
T:Iar::doe:r:l\\;:rd Pz — Maximum number of epochs 1g|}|}4;| = 00-30:00 at 1Hz rate
AssistNow Offline...
u-blox 7/MB Retrieve Log... |::>
GNSS Cenfiguration...
Preferences... K | Ead
Figure 8: Set maximum number of epochs to keep in database
& For long-term observations, it’s recommended to start recording a log file before analysis begins.
& If a high value of epochs is selected, the display of data in real-time cannot be guaranteed,
especially when graphical views are open.
UBX-13005250 - R0O6 Production Information Concept and philosophy
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4 u-center menus and windows

4.1 Main frame and toolbars

The main frame is the primary display screen of u-center. It displays all tool bars and some of the information
provided by the device. In the standard status bar, information about communication, UTC time, connection
time, used protocol (NMEA or UBX), used file, etc. is shown.

e Button tool tip: A description about each button in the toolbars can be obtained by holding the mouse
cursor over the button for a few seconds. A tool tip message will appear near the icon with additional
information while a detailed description is displayed in the status display.

" COMG - u- = D o

|

File Edit View Player Receiver Tools Window Help
DHEHS- &R 20 e AR B0 BE- @ - g
R R | BN TR E R R o Uy

Standard menu bar
Standard toolbar
Logfile toolbar

Standard status bar
Port information m Operating time
Status display Receiver generation

Ready == COMBS 9600 u-blox M& Mo file open NMEA 00:47:53  07:03:21 ’F y:

Figure 9: u-center main frame and toolbars

4.1.1 Standard menu bar

All u-center functions can be accessed through the standard menu bar. Commands can also be accessed by
shortcuts that are listed in the menus. Some often used operations are also available in the different toolbars.

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.1.1.1 File
Mew... Ctrl+M
Save .. Ctrl+5
Open... Ctrl+0
Close
Database Empty
Database Export 3
Print... Ctrl+P
Print Preview
Print Setup...
Recent Files J
Exit
Figure 10: File menu entries
Function Description Shortcut / Toolbar icon
Creates a new log file. No data is yet written but only
New... the file is opened. The duration of the logging time is ctr+n/ O
displayed in the status bar field Operating time.
Creates a new log file, saves the data from the internal
database to the log file and starts immediately
recording all new data from the receiver. This is useful
Save... when an error or an unexpected event occurred and no | ctrl+s / =
log file was recorded. The size of the ring buffer (4 MB)
is large enough to retain the data for the last hour
(approx.).
Open... Opens a stored log file to be replayed. CtrlI+O
Close Closes the active file. Ctrl+E /| &
Database Empty Deletes the internal database and all saved values. &5
Exports the internal database into HTML or KML data
Database Export formats for displaying with Google Map or Google
Earth.
Print... Prints the active document. Ctrl+P /
Print Preview Shows a preview of the print output.
Print Setup... Shows the setup dialog of the printer.
Recent Files Lists all recently used files. =
Exit Exits u-center.

Table 4: File menu entries

UBX-13005250 - RO6
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41.1.2 Edit
Cut Chrl+ X
Copy Ctrl+C
Paste Ctrl+V
Delete Del
Select All Ctrl+ 4
Clear All Ctrl+Del

Figure 11: Edit menu entries

Function Description Shortcut / Toolbar icon
Cut Cut the current selection and put in to the clipboard Ctrl+X /

Copy Copy the current selection to the clipboard Ctrl+C /

Paste Paste the clipboard content to the current position Ctrl+V /

Delete Delete the current selection Del

Select All Select all in the current view Ctrl+A

Clear All Clear all in the current view Ctrl+Del

Table 5: Edit menu entries

The Edit menu is fully Microsoft Windows compliant.

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.1.1.3 View
Packet Console F6
Binary Console F7
Text Console F&
Messages View F9
Configuration View Ctrl+F9
Statistic View F10
Table View F11
Recent Table Views P —n 1 Index / Alt (HAE) / SVs Used / SVs Tracked / SV C/NO / HDOP
Google Earth
Map View
Perf Trace
Recent Map Views »
Chart View
Recent Chart Views »

Histogram View

Recent Histogram View 4
Camera View
Deviation Map F12
Sky View
Docking Windows > » Satellite Position
Toolbars P— v Standard Toolbar Satellite Level
| s e Satellite Level History
v Receiver Toolbar World Position
v Player Toolbar Data
Action Toolb
i cen Toalbar Altitude Meter
AssistNow Offline Toolbar
Compass
Speed Meter
Watch
Figure 12: View menu entries
Function Description Shortcut / Toolbar icon
Packet Console Opens the packet console. £6 / 2l
Binary Console Opens the binary console. £7 Tl
Text Console Opens the text console. Fs/ i
Messages View Opens the dialog with all supported messages. F9 /

Configuration View | Opens the dialog with all configuration messages. This | ctrl+F9 / (I
is a subset of the Messages View.

Statistic View Opens the statistic view with all data from the internal | 10/ [E]
database.
Table View Opens the empty table view. All values from the | p11/ E
UBX-13005250 - R06 Production Information u-center menus and windows
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internal database can be displayed individually.

Recent Table Views

Lists all the table views that have been opened. This
information comes from the Windows registry and is
also valid after a restart of u-center.

Google Earth Opens a window using the Google Earth plugin. (Read | &y
and accept the terms of usage the first time.)

Map View Opens a window allowing to display a map. e

Chart View Opens a window with chart functionality. All values | Eg
from the internal database can be displayed
individually.

Histogram View Opens a window with histogram functionality. All | #fH
values from the internal database can be displayed
individually.

Camera View Opens a window allowing to connect to a webcam and
visualize and save the image.

Deviation Map Opens a window with a position deviation map. F1o )

Sky View Opens a window with the sky view. The current | [
position of the satellites and their values from the
internal database are shown.

Docking Windows Opens a list with all available docking windows that
can be shown.

Satellite Position Shows or hide the current satellite positions.

Satellite Level Shows or hide the current satellite levels. ]

Sa.ltelllte Level Shows or hide the history of the satellite levels. |

History

World Position Shows or hide the current position on the world map. iEi

Data Shows or hide data from the navigation solution (like =
position, TTFF, accuracy and DOPS)

Altitude Meter Shows or hide the altitude meter.

Compass Shows or hide the compass. 3

Speed Meter

Shows or hide the speed meter.

Watch

Shows or hide the clock.

Toolbars

Opens a list with all available toolbars that can be
shown.

Standard Toolbar

Shows or hide the standard toolbar.

Views Toolbar

Shows or hide the views toolbar.

Receiver Toolbar

Shows or hide the receiver toolbar.

Player Toolbar

Shows or hide the player toolbar.

Action Toolbar

Shows or hide the action toolbar.

AssistNow Offline
Toolbar

Shows or hide the AssistNow Offline toolbar.

Table 6: View menu entries

u-center menus and windows
Page 18 of 66
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4.1.1.4 Player

u-center - User Guide

Eject Ctrl+E
Stop Ctrl+H
Pause Ctrl+P
Record Ctrl+R
Step Ctrl+5pace
Play Ctrl+G » —Jpt T
Scan Ctrl+F
Slow
Goto Begin Mormal
Goto End Fast
Wery Fast
Repeat
Figure 13: Player menu entries
Function Description Shortcut / Toolbar icon
Eject Closes the active log file Ctrl+E /| =
Stop Stops reading or recording from the active log file ctri+H/ B
Pause Pauses reading or recording from the active log file Ctrl+P /
Record Starts recording to a new or already opened log file. | ctrj+Rr / #

Any data in the internal database will not be written to
the file. If you want to save this data into a log file,
open the File menu and click Save.

Step Single step function. The next message is read. Ctrl+Space / IV
Play Starts reading from the active log file. The speed of the | ctrl+G / ™
action can be chosen on the sub-menu.
Scan Reads the entire log file into the database and updates | ctrl+E/ M
the display at the end of the scan period
Goto Begin Sets the read position to the begin of the log file -
Goto End Sets the read position to the end of the log file =

Table 7: Player menu entries

UBX-13005250 - RO6 Production Information

u-center menus and windows
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4.1.1.5 Receiver

Port

Baudrate
Location API
Sensor API

Autobauding
Debug Messages

Generation

Action

Disconnect

COM1

COM4

COMS5

* COMB

P COMT7

Antaris
u-blox 5
u-blox 6
u-blox7
PT—» *  u-bloxM8

r— Hotstart
Warmstart
Coldstart
AssistNow Online...
MGA Online...
MGA Offline...

Save Config
Load Config
Revert Config

Figure 14: Receiver menu entries

u-center - User Guide

1'200
2'400
4'800
9'600
19'200
38'400
57'600
115'200
230'400
460'800
921'600

Function

Description

Shortcut / Toolbar icon

Port

Defines the port u-center connects to. The list is
generated automatically using the enumeration
method under Tools > Preferences > Generic
Enumerate serial ports using.

The currently used port will be indicated with a ».

dF -

Baud rate

Defines the baud rate of the communication. The list is
pre-defined and cannot be changed.

The currently set baud rate will be indicated with a ».

Location API

Connects to the receiver using the Location API

Sensor API

Connects to the receiver using the Sensor API (the USB
Sensor driver is required in this case)

Autobauding

Enables or disables autobauding for the current
communication with the receiver

UBX-13005250 - RO6

Production Information

u-center menus and windows
Page 20 of 66



@blox

u-center - User Guide

Debug Messages

Enables all debug messages in the receiver. Can be
requested by the u-blox support.

Defines the generation of the attached u-blox GNSS

information is deleted from the memory.

Generation receiver. u-center also tries to detect automatically the
correct generation.
Action Lists all possible actions that can be performed with the
u-blox GNSS receiver. This includes the following:
Sends a hotstart command to the receiver. No data is
Hotstart . ; I+
deleted in the receiver.
Sends a warmstart command to the receiver. Only the
Warmstart : Jle
ephemeris are deleted from the memory.
Coldstart Sends a coldstart command to the receiver. All Ic

AssistNow Online...

Opens the AssistNow Online dialog to aid the receiver
with satellite information.

This method is supported until u-blox 7 receivers.

MGA Online...

Opens the Multiple GNSS AssistNow Online dialog to
aid the receiver with satellite information from the
internet.

This method is only supported since u-blox M8
receivers.

MGA Offline...

Opens the Multiple GNSS AssistNow Offline dialog to
aid the receiver with satellite information from the
internet.

This method is only supported since u-blox M8
receivers.

(=
=l

Save Config

Saves the current receiver configuration to the memory
so that it will be loaded after a restart.

Load Config

Loads the last saved configuration from the memory.

&

Revert Config

Deletes all configurations in the memory and reverts
the receiver to the default configuration.

Table 8: Receiver menu entries

UBX-13005250 - RO6

Production Information

u-center menus and windows
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4.1.1.6 Tools

Firmware Update Antaris ...
Firmware Update u-blox 5/6/7/M&...

Dump Receiver Diagnostics...

AssistMow Offline...

u-blox 7/M8 Retrieve Log...
GMSS5 Configuration...

Preferences...

Figure 15: Tools menu entries

u-center - User Guide

Some of the menu items will only be displayed when the correct receiver generation is connected and identified
by u-center. If you cannot select one option, change the receiver generation under Receiver - Generation.

Function

Description

Shortcut / Toolbar icon

Firmware Update
Antaris...

Opens the firmware update dialog for u-blox Antaris
generation receivers.

Firmware Update u-
blox 5/6/7/M8...

Opens the firmware update dialog for u-blox 5-M8
generation receivers.

Dump Receiver
Diagnostics...

Tool to create the receiver diagnostic. Can be
requested by the u-blox support team.

AssistNow Offline...

Opens the AssistNow Offline dialog.
This is supported only until u-blox 7 receivers.

u-blox 7/M8
Retrieve Log...

Opens the dialog to download log information from
the receiver.

This is supported only since u-blox 7 receivers.

GNSS
Configuration...

Opens the dialog to save the receiver configuration to a
file on the PC or to restore a configuration from a file
on the PC.

Preferences...

Opens the dialog for the u-center preferences.

Table 9: Tools menu entries

4.1.1.7 Window

Cascade
Tile Horizontally
Tile Vertically

Close All

Save Workspace As .

Restore Workspace From ...

Recent Workspace
Arrange Icons

v 1 Packet Console

Figure 16: Window menu entries

UBX-13005250 - RO6

Production Information

u-center menus and windows
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Function Description Shortcut / Toolbar icon
Cascade Arranges all open dialogs cascaded.

Tile Horizontally Arranges all open dialogs horizontally.

Tile Vertically Arranges all open dialogs vertically.

Close All Closes all open dialogs and windows.

Save Workspace Allows to save the position of the open dialogs and
As... windows to a file on the computer.

Restore Workspace | Allows to restore the position of the dialogs and
From... windows from a file on the computer.

Recent Workspace Lists all recently used workspace files.

Arrange Icons Arranges the icons at the bottom of the window.

List of dialogs and | Lists all visible and hidden dialogs and windows in u-
windows center.

Table 10: Window menu entries

4.1.1.8 Help

Contents... F1

About u-center...

Figure 17: Helpmenu entries

Function Description Shortcut / Toolbar icon
Contents... References to this user guide. F1
About u-center... Shows the about dialog with the software version and

the used libraries and their versions.

Table 11: Help menu entries

4.1.2 Standard toolbar

The standard toolbar gives access to standard operations like opening and saving files, print the current view or
empty the database.

OE =~ &

|—De|ete internal database
Paste content from clipboard
Copy content to clipboard
Cut content to clipboard
Print preview

Print
Open file (and list recent files)
Save file
New file
Figure 18: Standard toolbar entries
UBX-13005250 - R0O6 Production Information u-center menus and windows

Page 23 of 66



@b I Ox u-center - User Guide

4.1.3 Views toolbar
222 EPOoDO-oG-B-mM- OO E0NGEEONRG S|

I—Show docking window 'Altitude Meter’

Show docking window 'Clock’

Show docking window 'Speed Meter'

Show docking window 'Compass’

Show docking window 'Satellite Data

Show docking window "World Position”

Show docking window 'Satellite Levels'

Show docking window 'Satellite Levels Histary'

Show docking window 'Satellite Positions'

Show window 'Sky View'

Show window "Deviation Map'

Show window "Histogram View' (including list of last views,
Show window "Chart View' (including list of last views)
Show window 'Map View' (including list of last views)
Show window 'Google Earth View'

Show window "Tabular View" (including list of last views)
Show window "Statistic View'

Show window 'Canfiguration View'

Show window "Messages View'

Show window "Text Console’

Show window "Binary Consale’

Show window "Packet Consale’

Figure 19: Views toolbar entries
4.1.4 Communication toolbar

KR

I « I +

|—Enable debug messages in receiver
—Toggle autobauding
Baud rate selection
Port selection

Figure 20: Communication toolbar entries

4.1.5 Log file toolbar
AE|(N[®[Dr~-»K ] A

gGoto end of log file

Goto position of log file

Goto begin of log file

Scan of log file

Play of log file (including speed selection)
Step of log file

Record of log file

Pause of replay of log file

Stop of log file

Eject log file

Figure 21: Log file toolbar entries

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.1.6 Action toolbar
Iiw e IS & & @

l—Revert receiver configuration
Load receiver configuration from memory

Save receiver configuration to memory
Multiple GNSS AssistNow Online
Multiple GNSS AssistNow Offline
AssistNow Online
Send coldstart command to receiver
Send warmstart command to receiver
Send hotstart command to receiver

Figure 22: Action toolbar entries

4.1.7 Standard status bar

The standard status bar is updated automatically and shows the information about the opened file, the
connection and the time.

The following fields are available:
Status display: Displays the current action or the function of a button if the mouse cursor is over the button
Port information: Shows the active COM port and baud rate.

Color coding of the icon:

T Disconnected

= Waiting for first data

“® Data is being received but errors are detected (mostly because of wrong baud rate settings)
*®= | ast data received was valid but there is no data to collect at this time

= \o data is being received but errors have been detected in the past

I Data is being received and collected at the correct baud rate

Receiver generation: u-center tries to automatically detect the type of device connected and activates the
appropriate mode of operation in order to take optimal advantage of the features. The mode can also be
manually selected through the menu bar (Receiver - Generation).

File: As soon as a file is used (this file must first be opened) the name of the file will be displayed (xxxxxx.ubx).

Protocol information: This box indicates the current message set that is being used to communicate with the
device. This can be the NMEA-0183 standard or the UBX protocol. The UBX protocol provides more
extensive information with the receiver. u-center can handle both protocols.

Operating time: The time elapsed since you started u-center.
UTC time: The current time sent by the device. This field is only updated if a receiver is connected.

4.2 Views and windows

4.2.1 Packet console
The packet console lists all incoming messages and provides information about message length and type.

UBX-13005250 - RO6 Production Information u-center menus and windows
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"GNS5 Satellites in view'

'GNSS Satellites in view'

"GNSS Satellites in view'

‘Geographic Position - Latitude/Longitude’
'Recommended Minimum Specific GNSS Data’
‘Course Over Ground and Ground Speed’
'Global Positioning System Fix Data’

DOF and Active Satellites’

DOP and Active satellites’

"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS

Satellites
satellites
Satellites
satellites
Satellites
satellites
Satellites

View'
view'
Wiew
wview
Wiew
wview
View

s

‘Geographic position - Latitude/Longitude’
"Recommended Minimum Specific GNSS Data’
‘course over Ground and Ground Speed’
‘Global Positioning System Fix Data’

DoP and Active Satellites’

DOP and Active satellites’

"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS

satellites
Satellites
satellites
Satellites
Satellites
Satellites
Satellites

view'
View'
view
Wiew
View
Wiew
View

'Geographic Position - Latitude/Longitude’
‘Recommended Minimum Specific GNSS Data’
"Course Over Ground and Ground Speed’
‘Global Positioning System Fix Data’

DoP and active satellites’

DOP and Active satellites’

"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS
"GNSS

satellites
Satellites
satellites
Satellites
satellites
Satellites
satellites

in
in
in
in
in
in
in

view'
View'
wview
Wiew
wview
Wiew
wview

m

'Geographic Position - Latitude/Longitude’

Packet Console
16:19:08 NMEA GLGSV,
16:19:08 NMEA GLGSV,
16:19:08 MNMEA GLGSV,
16:19:08 NMEA GMNGLL,
16:19:09 NMEA GNRMC,
16:19:09 NMEA GNVTG,
16:19:09 NMEA GNGGA,
16:19:09 NMEA GNGSA,
16:19:09 NMEA GNGSA,
16:19:09 NMEA GPGSV,
16:19:09 NMEA GPGSVY,
16:19:09 NMEA GPGSWV,
16:19:09 NMEA GPGSVY,
16:19:09 NMEA GLGSV,
16:19:09 NMEA GLGSV,
16:19:09 NMEA GLGSV,
16:19:09 NMEA GNGLL,
16:19:10 NMEA GNRMC,
16:19:10 NMEA GNWVTG,
16:19:10 NMEA GNGGA,
16:19:10 NMEA GNGSA,
16:19:10 NMEA GNG5A,
16:19:10 NMEA GPGSV,
16:19:10 NMEA GPG5SV,
16:19:10 NMEA GPGSV,
16:19:10 NMEA GPG5SV,
16:19:10 NMEA GLGSV,
16:19:10 NMEA GLGSV,
16:19:10 NMEA GLGSV,
16:19:10 NMEA GNGLL,
16:19:11 NMEA GNRMC,
16:19:11 NMEA GNWTG,
16:19:11 NMEA GNGGA,
16:19:11 NMEA GNGSA,
16:19:11 NMEA GNGSA,
16:19:11 NMEA GPGSVY,
16:19:11 NMEA GPGSV,
16:19:11 NMEA GPGSVY,
16:19:11 NMEA GPGSV,
16:19:11 NMEA GLGSV,
16:19:11 NMEA GLGSV,
16:19:11 NMEA GLGSV,
16:19:11 NMEA GNGLL,
@ X |

Figure 23: Packet console

Refer to Table 12 for an explanation of the icons and text fields.

UBX-13005250 - RO6
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4.2.2 Binary console
The binary console lists all incoming messages in binary and ASCII format.

Binary Console EI@
0010 2C 31 33 2C 31 30 2C 31 36 2C 30 34 2¢ 20 37 2¢ ,13,10,16,04,07, -
0020 32 33 2C 2C 2C 2C 2C 31 2E 32 36 2C 30 2E 37 30 23,,,,,1.26,0.70
0030 2C 31 2E 30 35 2a 31 43 0D 0A , 1. 05%1C:

16:19:01 0000 24 47 4E 47 53 41 2C 41 2C 33 2C 38 38 2C 37 35 S3$GNGSA,A,3,88,75
0010 2C 38 31 2C 36 35 2C 37 32 2C 37 34 2C 36 36 2C  ,81,65,72,74,66,
0020 733 2C 2C 2C 2C 2C 31 2E 32 36 2C 30 2E 37 30 73,,,,,1.26,0.70
0030 2C 31 2E 30 35 2A 31 30 OD 0A , 1. 05%10z7

16:19:01 0000 24 47 50 47 53 56 2C 34 2C 31 2C 31 34 2C 30 32 3$GPGsV,4,1,14,02
0010 2C 32 38 2C 33 31 30 2C 34 33 2C 30 34 2C 35 38 ,28,310,42,04,58
0020 2C 32 35 36 2C 35 30 2C 30 37 2C 33 30 2C 31 37 ,256,50,07,30,17
0030 35 2C 34 34 2C 30 38 2C 30 33 2C 31 38 I8 2C 2A 5,44 ,08,02,188,*
0040 7 34 0D 0A Ty

16:19:01 0000 24 47 50 47 53 56 2C 34 2C 32 2C 31 34 2C 30 39 35GPG5V,4,2,14,09
0010 2C 30 31 2C 31 39 35 2C 2C 31 30 2C 34 37 2C 32 ,01,195,,10,47,2
0020 39 36 2C 34 37 2C 31 33 2C 38 36 2C 32 37 32 2C 96,47,13,86,272,
0030 34 38 2C 31 36 2C 30 38 2C 30 38 30 2C 33 36 2A 48,16,08,080, 36"
0040 7 36 0D 0A 76gq

16:19:01 0000 24 47 50 47 53 56 2C 34 2C 33 2C 31 34 2C 31 37 3$GPGsV,4,3,14,17
0010 2C 30 32 2C 32 32 33 2C 2C 32 20 2C 33 32 2C 31 ,02,223,,20,32,1
0020 31 32 2C 34 39 2C 32 33 2C 35 39 2C 30 35 38 2C 12,49,23,59,058,
0030 34 38 2C 33 32 2C 30 31 2C 31 20 36 2C 31 39 2A 48,32,01,106,19*
0040 7 33 0D 0A EE

16:19:01 0000 24 47 50 47 53 56 2C 34 2C 34 2C 31 34 2C 33 33 3%GPG5V,4,4,14,33
0010 2C 33 31 2C 32 31 31 2C 33 37 2C 33 39 2C 33 33 ,31,211,37,39,33
0020 2C 31 35 38 2C 33 38 2A 37 35 0D QA ,158,38%7 5.7

16:19:01 0000 24 47 4C 47 53 56 2C 33 2C 31 2¢ 31 31 2Cc 36 35 $%GLG5V,3,1,11,65
0010 2C 36 30 2C 33 32 35 2C 34 39 2C 36 36 2C 31 35 ,60,325,49,66,15
0020 2C 32 39 30 2C 34 38 2C 37 31 2C 30 30 2C 30 39 ,290,48,71,00,09
0030 36 2C 2C 37 32 2C 34 36 2C 30 37 34 2C 34 38 2A 6,,72,46,074,48"
0040 36 39 0D 0A 697

16:19:01 0000 24 47 4C 47 53 56 2C 33 2C 32 2C 31 31 2C 37 33 3%GLGSV,3,2,11,73
0010 2C 31 35 2C 30 32 34 2C 34 31 2C 37 34 2C 34 38 ,15,024,41,74 48
0020 2C 30 37 32 2C 35 32 2C 37 35 2C 33 34 2C 31 34 ,072,52,75,34,14
0030 36 2C 34 38 2C 38 31 2C 32 37 2C 33 31 34 2C 34 6,48,81,27,314,4
0040 39 2A 36 37 0D OA 9%07 7

16:19:01 0000 24 47 4C 47 53 56 2C 33 2C 33 2C 31 31 2C 38 32 3%GLGSV,3,3,11,82
0010 2C 30 31 2C 33 35 35 2C 33 38 2C 38 37 2C 30 32 ,01,355,38,87,02
0020 2C 32 20 39 2C 2C 38 38 2C 32 38 2C 32 35 31 2 ,209,,88,28,251,
0030 353 30 2A 35 39 0D OA 50%59y7

16:19:01 0000 24 47 4 47 4C 4C 2C 34 37 31 37 2E 31 31 33 31 S$GNGLL,4717.1131
0010 39 2C 4 2C 30 30 38 33 33 ZE 39 31 35 36 39 2C 9,N,00833.91569,
0020 45 2C 31 36 31 39 30 31 2e 30 20 2C 41 2C 44 2A E,161901.00,A,D*
0030 7 38 0D 0A 787

m

@ | X |G |

Figure 24: Binary console

Refer to Table 12 for an explanation of the icons and text fields.
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4.2.3 Text console
The text console displays the content messages in textual form such as UBX-INF or NMEA messages.

NMEA messages are shown with heading $Gxyyy, where x stands for the satellite system (P = GPS, SBAS, QZSS,
L = GLONASS, A = Galileo, B = BeiDou, N = Any combination of GNSS) and yyy for the type of message (e.g.
ZDA=Time & Date).

Text Console =1 5
16:17:35 3%GLGSV,3,1,11,65,59,323,49,66,14,289,49,71,01,095,12,72,47,072,49%6A -
16:17:35 $6LGSV,3,2,11,73,16,024,42,74,48,072,49,75,34,147,47,81,27,315,48%63
16:17:35 %GLGSV,3,3,11,82,01,355,34,87,03,210,,88,28,252,51*5E
16:17:35 S$GNGLL,4717.11189,N,00833.91543,E,161735.00,A,D%72
16:17:36 $GNRMC,161736.00,A,4717.11186,N,00833.91546,E,0.006,,061213,,,D%63
16:17:36 $GNVTG,,T,,M,0.006,N,0.012,K,D*3D
16:17:36 $GNGGA,161736.00,4717.11186,N,00833.91546,E,2,12,0.70,500.6,M,47.3,M,,0000%4F
16:17:36 $GNGSA,A,3,02,20,13,10,16,04,07,23,,,,,1.26,0.70,1.04%1D
16:17:36 $GNGSA,A,3,88,75,81,65,72,74,66,73,,,,,1.26,0.70,1.04%11
16:17:36 S%$GPGSV,4,1,14,02,28,310,45,04,58,257,50,07,29,175,42,08,03,188,*7D
16:17:36 3$GPGSV,4,2,14,09,00,195,,10,47,296,48,13,86,267,48,16,07,081,36%72
16:17:36 S$GPGSV,4,3,14,17,02,224,,20,33,112,48,23,59,058,48,32,02,106,35%79
16:17:36 3$GPGSV,4,4,14,33,31,211,38,39,33,158,38%7A
16:17:36 $%6LGsv,3,1,11,65,59,323,50,66,14,289,48,71,01,095,12,72,47,072,49%a3
16:17:36 3%GLGSV,3,2,11,73,16,024,42,74,48,072,49,75,34,147 ,47,81,27,315,48%63
16:17:36 $%6LGsv,3,3,11,82,01,355,34,87,03,210,,88,28,252,51%5E
16:17:36 $GNGLL,4717.11186,N,00833.91546,E,161736.00,A,D%76
16:17:37 S$GNRMC,161737.00,A,4717.11185,N,00833.91547 ,E,0.003,,061213,,,0%65
16:17:37 $GNVTG,,T,,.M,0.003,N,0.005,K,D*3E
16:17:37 S$GNGGA,161737.00,4717.11185,N,00833.91547,E,2,12,0.70,500.6,M,47.3,M,,0000%4C
16:17:37 $GNGSA,A,3,02,20,13,10,16,04,07,23,,,,.1.26,0.70,1.04%1D
16:17:37 S$GNGSA,A,3,88,75,81,65,72,74,66,73,,,,,1.26,0.70,1.04%11
16:17:37 $GPGSV,4,1,14,02,28,310,44,04,58,257,50,07,29,175,42,08,03,188,%7C
16:17:37 $GPG5v,4,2,14,09,00,195,,10,47,296,48,13,86,267,48,16,07,081,36%72
16:17:37 $GPGSV,4,3,14,17,02,224,,20,33,112,48,23,59,058,48,32,02,106,34%78
16:17:37 S$GPG5V,4,4,14,33,31,211,38,39,33,158,38%7A
16:17:37 %GLGSV,3,1,11,65,59,323,51,66,14,289,48,71,01,095,12,72,47,072,49%62
16:17:37 $G6LGSV,3,2,11,73,16,024,42,74,48,072,49,75,34,147,47,81,27,315,48%63
16:17:37 $6LGSV,3,3,11,82,01,355,34,87,02,210,,88,28,252,50%5F
16:17:37 $GNGLL,4717.11185,N,00833.91547 ,E,161737.00,A,D"78
16:17:38 S$GNRMC,161738.00,A,4717.11184 ,N,00833.91548,E,0.004,,061213,,,D%63
16:17:38 $GNVTG, ,T,,M,0.004,N,0.007,K,D*3B
16:17:38 S$GNGGA,161738.00,4717.11184 ,N,00833.91548,E,2,12,0.70,500.5,M,47.3,M,,0000%4E
16:17:38 $GNGSA,A,3,02,20,13,10,16,04,07,23,,,,,1.26,0.70,1.04%1D
16:17:38 $GNGSA,A,3,88,75,81,65,72,74,66,73,,,,,1.26,0.70,1.04%11
16:17:38 3%GPGSV,4,1,14,02,28,310,44,04,58,257,50,07,29,175,42,08,03,188,*7C
16:17:38 $GPGsV,4,2,14,09,00,195,,10,47,296,48,13,86,267,48,16,07,081,36%72
16:17:38 3%GPGsV,4,3,14,17,02,224,,20,33,112,48,23,59,058,48,32,02,106,34*78
16:17:38 S$GPGsv,4,4,14,33,31,211,38,39,33,158,38%7A
16:17:38 3%GLGSV,3,1,11,65,59,323,51,66,14,289,48,71,01,095,12,72,47,072,49%62
16:17:38 $%GLGsv,3,2,11,73,16,024,42,74,48,072,49,75,34,147 ,47,81,27,315,48%a3 |
16:17:38 3%GLGSV,3,3,11,82,01,355,35,87,03,210,,88,28,252,50%5E £
16:17:38 S$GNGLL,4717.11184,N,00833.91548,E,161738.00,A,D%79
@ | X |
Figure 25: Text console displaying UBX-INF and NMEA messages
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Text Console =R (E=R>
16:27:56 3$GNRMC,162756.00,A,4717.11219,N,00833.91482,£,0.014,,061213,,,D%69 .
16:27:57 $GNRMC,162757.00,A,4717.11219,N,00833.91481,E,0.008, ,061213,,,D%66
16:27:58 $GNRMC,162758.00,A,4717.11218,N,00833.91481,€,0.016,,061213,,,D%67
16:27:59 $GNRMC,162759.00,A,4717.11219,N,00833. 91481 ,£,0.008, ,061213,, ,D*68
16:28:00 $GNRMC,162800.00,A,4717.11219,N,00833.91481,€E,0.008,,061213,,,D%GE
16:28:01 $GNRMC,162801.00,A,4717.11217,N,00833.91481,€,0.001,,061213,,,D%6D
16:28:02 $GNRMC,162802.00,4,4717.11215,N,00833.91482,E,0.004,,061213,, ,D%6A
16:28:03 $GNRMC,162803.00,A,4717.11214,N,00833.91481,€,0.005,,061213,,,D%68
16:28:04 $GNRMC,162804.00,A,4717.11212,N,00833.91480,E,0.005,,061213, ,,D*68
16:28:05 $GNRMC,162805.00,A,4717.11210,N,00833.91477,€,0.004,,061213,,,D%62
16:28:06 SGNRMC,162806.00,A,4717.11208,N,00833, 91472 E,0. 014, 061212, | \D*6C
16:28:07 $GNRMC,162807.00,A,4717.11208,N,00833.91470,€E,0.008,,061213,,,D%62
16:28:08 3$GNRMC,162808.00,A,4717.11209,N,00833.91470,€E,0.005,,061213,,,D%61
16:28:09 $GNRMC,162809.00,A,4717.11211,N,00833.91469,E,0.006, ,061213,,,D%62
16:28:10 $GNRMC,162810.00,A,4717.11212,N,00833.91469,€E,0.007,,061213,,,D%68
16:28:11 $GNRMC,162811.00,A,4717.11214,N,00833. 91468 ,E,0.006, ,061213,, ,D*6F
16:28:12 $GNRMC,162812.00,A,4717.11215,N,00833.91468,E,0.012,,061213,,,D%68
16:28:13 $GNRMC,162813.00,A,4717.11216,N,00833,91468,E,0.005,,061213,, ,D%6C
16:28:14 $GNRMC,162814.00,A,4717.11217,N,00833.91469,€,0.003,,061213,,,D%6D
16:28:15 $GNRMC,162815.00,A,4717.11217,N,00833.91469,E,0.008,,061213,,,D%67
16:28:16 $GNRMC,162816.00,A,4717.11218,N,00833.91470,E,0.008, ,061213,,,D%63
16:28:17 $GNRMC,162817.00,A,4717.11217,N,00833.91472,€,0.006,,061213,,,D%61
16:28:18 $GNRMC,162818.00,A,4717.11214,N,00833.91472,£,0.012,,061213,,,D%69
16:28:19 $GNRMC,162819.00,A,4717.11211,N,00833.91473,€,0.021,,061213,,,D"6D
16:28:20 3$GNRMC,162820.00,A,4717.11208,N,00833.91473,€,0.009,,061213,,,D%65
16:28:21 $GNRMC,162821.00,A,4717.11205,N,00833.91473,E,0.006,,061213,,,D%66 =
16:28:22 $GNRMC,162822.00,A,4717.11203,N,00833.91473,€,0.002,,061213,,,D%67
16:28:23 $GNRMC,162823.00,A,4717.11200,N,00833.91474 ,£,0.002,,061213,,,D%63
16:28:24 $GNRMC,162824.00,A,4717.11199,N,00833.91474,€,0.007,,061213,,,D%63
16:28:25 $GNRMC,162825.00,A,4717.11198,N,00833,01473,E,0.002,,0612132,,,D%60
16:28:26 $GNRMC,162826.00,A,4717.11198,N,00833.91474,€,0.011,,061213,,,D%67
16:28:27 $GNRMC,162827.00,A,4717.11197,N,00833.91475,€,0.005,,061213,,,D%6D
16:28:28 $GNRMC,162828.00,A,4717.11196,N,00833.91476,E,0.006, ,061213,,,D%63
16:28:29 $GNRMC,162829.00,A,4717.11193,N,00833.91476,€,0.001,,061213,,,D%60
16:28:30 $GNRMC,162830.00,A,4717.11191,N,00833.91476,E,0.004,,061213,, ,D*6F
16:28:31 $GNRMC,162831.00,A,4717.11189,N,00833.91476,E,0.004,,061213,,,D%67
16:28:32 3$GNRMC,162832.00,A,4717.11187,N,00833.91475,E,0.008,,061213,,,D%65
16:28:33 $GNRMC,162833.00,A,4717.11186,N,00833.91474,E,0.011,,061213,, ,D*6C
16:28:34 $GNRMC,162834.00,A,4717.11184,N,00833.91473,€,0.005,,061213,,,D%6B
16:28:35 $GNRMC,162835.00,A,4717.11183,N,00833.91472,€,0.004,,061213,, ,D%6D
16:28:36 $GNRMC,162836.00,A,4717.11180,N,00833.91472,€,0.001,,061213,,,D%68
16:28:37 $GNRMC,162837.00,A,4717.11179,N,00833,901472,E,0.005,,0612132,, ,D*6E
16:28:38 $GNRMC,162838.00,A,4717.11178,N,00833.91471,€,0.009,,061213,,,D"6A
@ X RMC]|
Figure 26: Text console displaying only RMC messages
Element Name Description
3 / & Lock / Locked :i)r((:al\(/:gts the console from being updated with new data when
b Clear All Erases all data in the console
Filters unwanted data from the data stream. This allows
Filter On/Off searching for certain expression, e.g. all RMC messages (Figure
26).
Pauses the player when the search expression is found. Only
Pause player .
works in playback mode.

Table 12: Description of the buttons of the console views

4.2.3.1

Regular expression evaluation
Normally, when you search for a sub-string in a string, the match should be exact. So if we search for a sub-

string ""abc™ then the string being searched should contain these exact letters in the same sequence for a match
to be found. We can extend this kind of search to a case insensitive search where the sub-string "abc™ will find
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strings like ""Abc", "ABC" etc. That is, the case is ignored but the sequence of the letters should be exactly the
same. Sometimes, a case insensitive search is also not enough. For example, if we want to search for numeric
digit, then we basically end up searching for each digit independently. This is where regular expressions come in
to our help. Regular expressions are text patterns that are used for string matching. Regular expressions are
strings that contain a mix of plain text and special characters to indicate what kind of matching to do. Here's a
very brief tutorial on using regular expressions.

Suppose, we are looking for a numeric digit then the regular expression we would search for is "'[0-9]". The
brackets indicate that the character being compared should match any one of the characters enclosed within the
bracket. The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this regular expression
will match any character between 0 and 9, that is, any digit. If we want to search for a special character literally
we must use a backslash before the special character. For example, the single character regular expression ""\***
matches a single asterisk. In the table below the special characters are briefly described. A regular expression
search is case sensitive.

Character Description

A Beginning of the string. The expression A" will match an ‘A’ only at the beginning of the
string.
The caret (©) immediately following the left-bracket ([) has a different meaning. It is used to

- exclude the remaining characters within brackets from matching the target string. The
expression "'[0-9]" indicates that the target character should not be a digit.

$ The dollar sign ($) will match the end of the string. The expression ""abc$" will match the sub-
string ""abc™ only if it is at the end of the string.

| The alternation or logic OR character (|) allows either expression on its side to match the target

string. The expression "a|b" will match ‘a’ as well as ‘b’.
. The dot (.) will match any character.

- The asterisk (*) indicates that the character to the left of the asterisk in the expression should
match O or more times.

The plus (+) is similar to asterisk but there should be at least one match of the character to the

* left of the + sign in the expression.

? The question mark (?) matches the character to its left O or 1 times.

O The parenthesis affects the order of pattern evaluation.

] Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may

match the target character.

Table 13: Regular expression syntax

4.2.3.2 Example
Let’s assume that the following lines would appear in the NMEA console without filtering.

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A

14:00:03 $GPGSV,2,1,07,06,58,062,44,17,52,161,44,25,45,239,44,22,35,301,44*7F
14:00:03 $GPGSvV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:03 $GPRMC,140003.242,A,4717.1126 ,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:03 $GPVTG,80.59,T, ,M,0.03,N,0.1,K*56

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,, ,0000*0F
14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:04 $GPGSV,2,1,07,06,58,062,45,17,52,161,44,25,45,239,44,22,35,301,44*7E
14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

In the following examples the characters marked red match the regular expression.
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Example 1: Searching for the RMC with a valid position and all GGA Messages
“GP(GGA|RMC, .*,A,)”

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09
14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F
14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D

Example 2: Searching for all GSV with the message index of ‘2’ or ‘3’
“GSvV, .*,[2-3].,”

14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E
114:00:04  $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

Example 3: Searching for all messages starting with $GP, which have a ‘G’ in the message identifier but not
at the first position
“N\$CP.+G.*,”

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09
14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,, ,0000*0F
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

Example 4: Searching for all message having a checksum of which the higher nibble is 3
\*3.$”

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A
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The messages view is utilized to communicate with the device. Receiver output messages (e.g. navigation
output, status and debug information) are displayed; input messages (e.g. configuration messages) can be sent.
There are different sections for NMEA and UBX protocol.

-

5

[@] Messages - UBX - MON (Monitor) - VER (Version) [ ==
NM_EA B - MON [Monitor] - VER [Wersion) 9s
B- UBX
- ACK (Acknowledge) Software Yersion
@- AID (GPS Aiding)
- CFG (Cenfig) |2.U1 (75350)
@- ESF (External Sensor Fusion) Hardware Yersion
INF (Information) |uuusuuuu
@- LOG (Data Logger) Extension(s)
G- MGA (Multiple GNSS Assistance) 0.22 (67070)
=- MON (Monitor) FROTVER 15.00
- EXCEPT (Exception Dump) FIS [!“BFZE‘_m [75537!
.. GNSS (Default system settings) GPS.5BAS BLO BDS U255
HW (Hardware Status)
HW2 (Extended Hardware Status)
10 (10 System)
.. IPC (IPC / IRQ System)
- MSGPP (Message Parse & Process)
PATCH (Installed patches)
RXBUF (RX Buffer)
RXR (RX ready)
SCHD (Scheduler / Stack)
.. TXBUF (TX Buffer) Message Display
i USB (USB Status) Decodes and visualizes
: : the content of the
- NAV (Navigation) message.
- RXM (Receiver Manager)
& TIM (Timing) 0000 BS 62 OR 04 RO 00 32 2E 30 31 20 28 37 35 ubdd J2.01 (75 A
5 USR (User) 000OE 33 35 30 29 00 00 00 00 00 00 00 00 00 00 350){PP787487
L 2.2 (Unknown) 001C 00 00 00 00 00 00 00 00 30 30 30 38 30 30 JJJ7P9777000800
- o 002A2 30 30 00 00 30 2E 32 32 20 28 36 37 30 37 00J780.22 (€707
fi-1t {Custom) 0038 30 22 00 00 00 OO0 00 00 00 00 00 00 00 00 0)JMFPIPEFI2ET
& USERD 0046 00 00 00 00 00 00 50 52 4F 54 56 45 52 20 Q2J7JJPROTVER
UNKNOWN 0054 31 35 2E 30 30 00 00 00 00 00 00 00 00 00 15.000330772%7
CUSTOM 0062 00 00 00 00 00 00 00 00 46 48 53 20 30 78 JJJPPPPJFIS 0x
0070 42 46 32 36 30 31 20 28 37 36 35 33 37 29 BF2601 (76537)
Hex Dump 12 27 20 2% 55 22 44 i3 35 2 imasietorioers
Message tree ?é;ifxf the message 00 00 00 00 00 00 00 00 &C F& ZSSIPPIPF23218
A list of all NMEA and in .hexadecimal and
UBX messages. ASCIl form.
& | X | Bsend ipon | | & Toolbar

Figure 27: Message View
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Element Name Description

& 2 Lock / Locked Prevents the message view from being updated with new data
/ when locked.

> Clear All Erases the entire message view.

£E]Send Send Sends the current message to the device.

5% Poll Poll Polls the selected message once.

g Auto poll Automatically polls a newly selected message once

Message Hotkey Assigns a hotkey to the selected message

Table 14: Description of the buttons in the messages view toolbar
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4.2.41 Receiver output messages
Messages - NMEA - GxGGA (Global Positioning System Fix Data) = R
o ’;Mé‘:w Do feferenee “ || NMEA - GxGGA (Global Postioning System Fis Dats) L
[ﬂ GxGBS (Satellite fault Detection) - — Time in second
@ {GxGGA (Global Positioning System Fix C Parameter Yelue | Uni | Descrption since last update
: o : urc 074353.00 hhmmes.sss  Universal ime coordinsted
& GxGLL (Geographic Position - Latitude/| Lat AT ddmmmmmm  Latibude
- GxGNS (GNSS Fix Data) Notthing Indicater N N=Naith. 5=5outh
¥- GxGRS (GNSS5 Range Residuals Lon 00633.91480  dddmm.mmmm  Longitude
: T Easting Indicator E E=East. W=\West
o GxGSA (GNSS DOP and Active Sateltes) ff | g f 2 O=invalid, 1=20/30. 2-DGPS. 6-Dead Reckoning
2y GxGST (GNS5 Pseudorange Error Statisti S5 Used 12 Murnber of S¥s used for Navigation
7 GxG5V (GNSS Satellites in View) HDOP 0.60 Horizontal Dilution of Precision
- GxRMC (Recommended Minimum Speg El '[{MSL] 5[]1."".: i i'lit;d:e[ab-ove means sea level]
- GxTHS (Heading of Vehicle) Geoid Sep. 473 m Geoid Separation = ANHAE) - ANMSL)
GxTAT (Text Transmission) Unit M M=hdeters
e]- OxVLW (Dual Ground/Water Distance) Age of DGFS Con Age of Differential Conections
5_ GXVTG (Course Over Ground and Groun|= DGPS Ref Station 0000 1D of DGPS Reference Station
GxZDA (Time & Date)
- PUBX
! (Unknown)
7 (Custom)
B UBX
[?l ACK (Acknowledge)
E| AID (GPS Aiding)
[ﬂ CFG (Config)
[?l ESF (External Sensor Fusion)
... INF (Information) |Message Contentl
[ﬂ LOG (Data Logger)
& MGA (Multiple GNSS Assistance) 0000 24 47 4E 47 47 41 2C 30 37 34 33 35 33 2ZE $GNGGA,074353. -
&- MON (Manitor) O00E 30 30 2C 34 37 31 37 2E 31 31 32 31 33 2C 00,4717.11213,
H .. EXCEPT (Exception Dump) 001C 4E 2C 30 30 368 33 33 2E 39 31 34 36 30 2C N,00833.91480,
o : ) 002a 45 2C 32 2C 31 32 2C 30 2E 36 30 2C 35 30 E,2,12,0.60,50
- GNSS (Default system settings) 0038 31 2E 37 2C 4D 2C 34 37 2E 33 2C 4D 2C 2C  1.7,M,47.3,M,,
Message tree atus) 0046 30 30 30 30 2A 34 38 0D 0OA 0000*48484
Black text indicates  Jardware Status)
that the message was
received in the last  ftem)
second. Parse & Process)
Grey text means that |patches)
the message was )
never received or no
new data is available. —s S =2
@ X | o | 28 Toolbar

Figure 28: Message display of an output message

&

Double-clicking on an output message enables or disables the periodic message update if the
communication protocol is active. This feature is currently only supported for the UBX protocol.

4.2.4.2 Receiver input messages

Input messages can be edited and sent to the device from the messages view. It is also possible to poll the
current receiver settings.

&

u-center performs some range checks on input messages. If an input value exceeds the permitted range,
u-center will highlight the field in red but it is still possible to send the value to the receiver. However, the
receiver is likely to reject such a message.
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4.2.5 Statistic view

Statistic View = =R
Title Count Age Current Minimum Maximum Average Deviation Unit | Description -
uTC 3475 0 08:00:01000.. 07.01:36.000.. 0800:01.000.. time d..  Time UTC E
GPS time 3475 0 1770115217 1770:111712....  1770:115217.... wnoitow  Time GPS
TTAG 0 s TTAG (from ITOW)

TACC 0 0.000000 us  Time Accuracy
TimeStartup 0 0.000 s Time since Startup
TTFF 0 0.000 s Time to first fix

TMO rising 0 0.000000000 Timemark( Rising Edge
TMO falling 0 0.000000000 Timemark{ Falling Edge
TML rising 0 0.000000000 Timemarkl Rising Edge
TML falling 0 0.000000000 Timemarkl Falling Edge
TM2 rising 0 0.000000000 Timemark2 Rising Edge
TM2 falling 0 0.000000000 Timemark2 Falling Edge
TP Qerr 0 0.000 ns Timepulse Quantisatio...
Lat 3450 0 47.285206 47.285185 47.285227 47.285201 0.000008 ® Paosition LTP Latitude
Lon 3450 0 8.565248 8.565208 8.565257 8.565243 0.000008 ®  Paositien LTP Longitude
Alt (HAE) 3450 0 544.90 55310 54880 1.39 m  Position LTP Altitude (...
Alt (M5L) 3450 0 49760 505.80 501.50 1.39 m  Position LTP Altitude (...
X 3450 0 4286467 .36 4286473.27 4286470.76 110 m  Position ECEF X

Y 3450 0 64560585 645609.50 645608.23 0.59 m  Position ECEF Y

z 3450 0 466373167 4663738.20 4663734.21 1.08 m  Position ECEF Z
PACC3D 0 0.000 m  Position Accuracy 30
PACCH 0 0.000 m  Horizontal Position Ac...
PACCV 0 0,000 m  Vertical Position Accur...
VX 0 0.00 m/s  Velocity ECEF X

WY 0 0.00 m/s Velocity ECEF Y

VZ 0 0.00 m/s  Velocity ECEF Z

VN 0 0.00 m/s  Velocity LTP North

VE 0 0.00 mys  Welocity LTP East

VD 1] 0.00 ms  Velocity LTP Down
Speed 0 0.00 ms  Speed

506G 3450 Q 0.00 0.00 0.04 0.00 0.00 m/s  Speed over Ground

CoG 0 0.00 deg Course over Ground
Pitch 0 0.00 ® Pitch

VACC 3D 0 0.00 mis  Velocity Accuracy 3D =

Figure 29: Statistic View

All available database values (transmitted from the device or calculated by u-center) are displayed. The following
statistics are displayed:

- Current value

- Minimum value

- Maximum value

- Average value

- Standard Deviation
The following color scheme for the values is applied:

- Grey color: The value was not set for the current epoch
- Blue color: The value was calculated by the application from other data
- Empty field: No data is available

&
V=

Choosing ‘Database Empty’ in the file menu or pressing the button & clears the statistic view.
The content of the statistic view can easily be exported to other programs using Copy/Paste.

UBX-13005250 - RO6 u-center menus and windows
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4.2.6 Table view
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-

Table - [Index / UTC / Lat / Lon / Alt (HAE) / PACC 3D / VDOP] o[- 3]
Index UTC Lat Lon| Alt (HAE) VDOP| -
21 08:07:4200012/09/2013 47285219  8.565248 550.60 11
232 08:07:43.00012/09/2013 47285219  8.565249 550.60 11
233 08:07:44.00012/09/2013 47285219  8.565249 550.50 11
234 08:07:4500012/09/2013 47285219  8.565249 550.50 11
235 08:07:46.00012/09/2013 47285219  8.565250 550.40 11
236 08:07:47.00012/09/2013 47285219  8.565250 550,30 11
237 08:07:48.00012/09/2013 47285219  8.565250 550.20 11
238 08:07:49.00012/09/2013 47285219  8.565251 550.10 11
239 08:07:50.00012/09/2013 47285219  8.565251 550.10 11
240 08:07:51.00012/09/2013 47285219  8.565251 550.10 11
241 08:07:5200012/09/2013 47285219  8.565251 550.00 11
242 08:07:53.00012/09/2013 47285219  8.565251 550.00 11
243 08:07:54.00012/09/2013 47285219  8.565252 550.00 11
244 08:07:55.00012/09/2013 47285219  8.565252 549.90 11
245 08:07:56.00012/09/2013 47285219  8.565253 549.80 11
246 08:07:57.00012/09/2013 47285219  8.565253 549.80 11
247 08:07:58.00012/09/2013 47285218  8.565253 549.80 11
248 08:07:50.00012/09/2013 47285218  8.565254 549.80 11
249 08:08:00.00012/09/2013 47285217  8.565254 549.80 11
250 08:08:01.00012/09/2013 47285217  8.565254 549.80 11
251 08:08:02.00012/09/2013 47285217  8.565254 549.70 11
252 08:08:03.00012/09/2013 47285216  8.565254 549.70 11
253 08:08:04.00012/09/2013 47285216  8.565254 549.60 11
254 08:08:05.00012/09/2013 47285216  8.565254 549.60 11
255 08:08:06.000 12/09/2013 47285216  8.565254 549.50 11
256 08:08:07.00012/09/2013 47285216  8.565254 549.50 11
257 08:08:08.000 12/09/2013 47285216  8.565254 549.50 11
258 08:08:09.00012/09/2013 47285216  8.565254 549.50 11
259 08:08:10.00012/09/2013 47285216  8.565254 549.50 11
260 08:08:11.00012/09/2013 47285216  8.565254 549.50 11 |E
261 08:08:12.00012/09/2013 47285216  8.565254 549.60 11
261 08:08:12.00012/09/2013  47.285216  8.565254 549.60 11 -
= — ([RE— -

Figure 30: Table view

All values from the database can be displayed in a tabular form (Figure 30). This is very useful when analyzing
the log file in detail.

To add a new column, first select the desired value (Figure 31) and click the + button. To remove a displayed
value, click the ™ button. To see the table header click the E3 button. Statistical information will be shown.

ime date
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Index utc | Lat Lon| Alt(HAE)| PACC3D] vDOP| -
347 08:09:38.00012/09/2013 47285210  B.565253 55040 11
348 08:09:39.000 12/09/2013 47285210  8.565252 550.40 11
349 08:09:40.00012/09/2013 47285210  8.565252 550.40 11
350 08:09:41.00012/09/2013 47285210  8.565251 550.40 11
351 08:09:42.00012/09/2013 47285210 8565251 550.40 11
352 08:09:43.00012/09/2013 47285210  8.565251 550.30 11
353 08:09:44.00012/09/2013 47285210  8.565251 550.30 11
354 08:09:4500012/09/2013 47285211  B.565251 55040 11
355 08:09:46.00012/09/2013 47285211  8.565251 550.40 11
356 08:09:47.00012/09/2013 47285211  8.565252 550.40 11
357 08:09:48.000 12/09/2013 47285210  8.565252 550.50 11
358 08:09:49.00012/09/2013 47285210  8.565252 550.50 11
359 08:09:50.000 12/09/2013 47285209  8.565252 550.40 11
360 08:09:51.00012/09/2013 47285209  8.565253 550.40 11
361 08:09:52.00012/09/2013 47285208  B.565253 550.40 11
362 08:09:53.00012/09/2013 47285208  8.565253 550.40 11
363 08:09:54.00012/09/2013 47285208  8.565254 550.40 11
364 08:09:55.00012/09/2013 47285208  B.565254 550.50 11
365 08:09:56.00012/09/2013 47285208  8.565254 550.50 11
366 08:09:57.00012/09/2013 47285207  8.565254 550.50 11
367 08:09:58.00012/09/2013 47285207  8.565254 550.50 11
368 08:09:59.000 12/09/2013 47285207 8565254 550.50 11
369 08:10:00.00012/09/2013 47285207  8.565254 550.40 11
370 08:10:01.00012/09/2013 47285207  B.565254 550.30 11
Eval 08:10:02.00012/09/2013 47285207  B.565254 550.20 11
72 08:10:03.00012/09/2013 47285207  8.565254 550.10 11
373 08:10:04.00012/09/2013 47285208  8.565254 549.90 11
374 08:10:05.00012/09/2013 47285208  8.565253 549.90 11
375 08:10:06.00012/09/2013 47285208  8.565253 549.80 11
376 08:10:07.00012/09/2013 47285208  8.565252 549.80 11 %
377 08:10:08.00012/09/2013 47285208  8.565252 549.80 11
378 08:10:09.00012/09/2013 47285208  8.565252 549.70 1] |2
'@ + = [voop -

Figure 31: Selecting a new value

&

&
&

UBX-13005250 - RO6

The number of displayed epochs is set to 1800 by default (see also section 3.3).
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Choosing ‘Database Empty’ in the file menu or pressing the button & clears the table view.
The content of the table view can easily be exported to other programs using Copy/Paste.
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4.2.7 Google Earth

u-center features a Google Earth view and enhanced kml export for visualizing position and tracks with Google
Earth (see Figure 32).

Google Earth

Google
Bildaufnahmiedz2006:{8/19/2012 47°17'09.57" N

s =P H

416 m  sichthohe. 1.76 km

Figure 32: Google Earth view

& To use the Google Earth View acceptance of the Google Map API Terms of Service is required.

http://code.google.com/apis/maps/terms.html

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.2.8 Map view

u-center can display positions on pre-calibrated maps (Figure 33). This allows a basic analysis of road tests.

Map - [air-thalwil.png]
F 1 * o i 7 = N g 0 K. = = o Fa -

2R A

4 | mn | 2

Figure 33: Map view

4.2.8.1 Using map view
You can access the view specific commands in two different ways:

- Using the command in the tool bar below the map view.

- Holding the cursor inside the map view and pressing the right mouse button will. This will open the
following context menu (see Figure 34).

UBX-13005250 - RO6 Production Information u-center menus and windows
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*  Cursor
Move
Zoom In
Zoom Qut o
Fit Map Dot
Markers Lo
Follow Cross
Drawing Mede r —> Points N Bold Cross
Open Map... Connect g None
Recent Maps r -

Statistics Always

Copy *  (Consecutive

Figure 34: Map view context menu

Function Description Shortcut / Toolbar icon
The position of the cursor is shown on the lower left
edge of the u-center screen (Longitude, Latitude and
Cursor Pixel-Position). By holding the left mouse button and le
moving the cursor over the map you can measure
distance from one position to another
Move The map inside the map view window can be moved &+
Zoom In The map is enlarged by selecting a rectangle &,
Zoom Out The size of the Map is decreased =4
Zoom Factor Different specific zoom level can be selected 100% -
Fit Map The map size is adjusted to fit the Map Window Wi
Markers Add or remove the defined markers (see also section r
4.2.8.2, Map calibration) FOs
Follow Center the map on the current GNSS position -

The size and form of the displayed position can be
changed; the connection line between the points can

(only in toolbar)

Drawing Mode be selected in the menu Connect. To see statically -
values (average, minimum, maximum, standard
deviation) directly in the map, select the Menu Statistic.
Open Map... / -~
Recent Maps Load a new or one of 8 recently used maps. = -
Copy
Save ma _ .
P The current display can be stored in different formats (=] / =

Image settings
(only in toolbar)

Brightness, contrast and color saturation of map can be
adjusted by moving the glides

—
-—
—

Table 15: Description of the buttons and context menu entries in map view

& Map Views can be copied to the clipboard using the ‘Print Screen’ function.

UBX-13005250 - RO6
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& Choosing ‘Database Empty’ in the file menu or pressing the button & deletes all recently displayed
positions and routes.

4.2.8.2 Map calibration

To create your own map you will need a digitized map or pictures with orthogonal projection in one of the
following pixel graphics formats.

png Portable Network Graphics,
bmp Windows Bitmap

dib Device Independent Bitmap
gif Graphics Interchange Format
irg/ipeg Jpeg File Interchange Format
pcx PC paintbrush

tif Tag Image File Format

If your map is not in one of the above formats, you can simply convert it in one of the supported formats by a
third party program. u-blox provides two sample maps. Office.png is a small map of the surroundings of the u-
blox headquarters. World.png is a map of the whole world but with limited resolution.

To use a map in u-center, three calibration points are needed. For these points you have to know the pixel
coordinates and the according WGS84 coordinates in the latitude/longitude format in degrees (longitude: -180.0
to 180.0, latitude: -90.0 to 90.0). These points are stored in the map calibration file. The calibration file must be
stored at the same location as the bitmap itself. It has the same name but a different extension (*.mcf). The
format of the calibration file is very simple and can be edited in a simple editor like notepad.

Examples:

As an example we will have a closer look at the provided map ‘world.png' and its calibration file *world.mcf".
Y/X >

v
Figure 35: Digital map file: world.png

The Map has 1765 Pixels (0 to 1764) in the horizontal and 1046 Pixels (O to 1045) in the vertical direction. The
origin is the upper left corner. To calibrate this map we will use the following three calibration points (#1 to #3).

Pixel WGS84 Coordinate
Reference Point # | X Y Longitude | Latitude
Upper Left Corner 110 0 -180.0 90.0
Lower Right Corner 2 |11764 | 1045 | 180.0 -90.0
Upper Right Corner 31764 |0 180.0 90.0
UBX-13005250 - R0O6 Production Information u-center menus and windows
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To determine the exact pixel position you can use Microsoft Paint (mspaint.exe) or any other pixel-editing
program.

The calibration file is a plain ASCII text file. The file may contain comments. The file consists of two sections,
which start with keywords encapsulated in braces.

The REFERENCE section, which is mandatory, contains the three points used to calibrate a map. Each reference
point is on a single line and has the following syntax:

“# = <x>, <y>, <lon>, <lat>”

where # is the index of the reference point <x> is the horizontal and <y> is the vertical image coordinate and
<lat> is the latitude and <lon> is the longitude in degrees and WGS84.

The optional MARKER section defines additional points on the map. Each point is on a single line with the
syntax:

“# = 0, <x>, <y>[, <text>]” or “# = c, <lat>, <lon>[, <text>]”

where # is the index of the marker point <x> is the horizontal and <y> is the vertical image coordinate or <lat>
is the latitude and <lon> is the longitude in degrees and WGS84. <text> is a optional string in quotes labeling

the marker point. The points must have a unique index from 1 to <num>. The maximum marker point index
<num> is written to the same section on a separate line with the syntax “Count = <num>"".

; File: world.mcf
; Source: (sample data set)

cREFERENCE

; 3 Points must be defined to calibrate a Map
; Parameters:

; # = index of the point (1 to 3)

; X,y = image coordinates

; lat, lon world coordinates
; Syntax:

: # = <x>, <y>, <lon>, <lat>
[REFERENCE]

1= 0, 0, -180.0, 90.0
2 = 1764, 1045, 180.0, -90.0
3 = 1764, 0, 180.0, 90.0

You can add points (image or world coord) to the map
; Parameters:

; num = number of markers that follow
; # = index of the point (1 to num)
; type = c¢ for world or i image coordinates
; X,y = image coordinates
; lat,lon = world coordinates
; text = quoted text decription to the marker (optional)
; Syntax:
Count = <num>
; # = <type>, <x|lon>, <y|lat>[, <text>]
[MARKER]
Count = 1

1 =c, 8.56525, 47.28519444, "u-blox ag"

Map calibration file: world.mcf

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.2.8.3 Map calibration tool

u-center includes a built-in calibration tool for providing coordinates to maps and photographs in supported data
formats to create u-center maps. To use the tool open the map view window as seen in Figure 36 and then as
seen in Figure 37 open the file of the map to be calibrated (in our example GoogleScreenShot.bmp).

‘u u-center 6.3
File Edit

VDN Plaver Receiver Tools  Window

N Packet Console F&
: Binary Console F7
fame - U Text Console F&

E | Messages View Fa
d Configuration Yiew Chrl+F9

Statistic Yiew F10
Table Yiew Fi1
Recent Table Views L |

Google Earth

Chart Yiew
Recent Chart Yiews r @
Histogram View

Recent Histogram Yiew »
Camera Wigw

Deviation Map F1z
Sky Yiew

Docking Windows y @
Toolbars 3

Figure 36: Opening map view window

Laak ir: |lf) u-center j & £k EB-

J .:] World.png

Recent

ol

Desktop

\$

My Documents

@

My Computer

My Metwark, File name: |GoogIeScreenShot.bmp j Open |
Flaces
Files of type: |Map Files [".png;".ipg;".ipeg;".gif;".tif;".pcx;".bmﬂ Cancel

Figure 37: Opening the file of the map to be calibrated

If the file to be opened has not been calibrated, the following message will appear:

There iz no calibration file for this map. Pleaze press Yes to start the calibration process:
. first click on a known position inside the map, then enter the coordinates inta the dialog box.
Atftention: position click plus coordinates entering has to be repeated three times!

UBX-13005250 - RO6 Production Information u-center menus and windows
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Select three points on the map and enter the calibration coordinates in the specified format as seen in Figure 38,
Figure 39 and Figure 40.

£ Map - [GoogleScreenShat. bmp] 7 |;”§||g\

)

Coordinate System

| [wWG584 LatsLon in Degree, Minutes and Seconds | Cancel

Lon® |8 Lon' |33 Lon" |48.08
Lat® |47 Lat' [17 Lat" {1193

Coordinate System

\ |WES84 Lat/Lon in Deares, Minutes and Seconds ~|  Cancel

Lon* [B Lor' [345 Lon" [32
Lat* (9.49

&
boh B R - F e A 2-EHE W

Figure 39: Calibrating a map using calibration tool (position 2)

UBX-13005250 - RO6 Production Information u-center menus and windows
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Coordinate System

| |WGSBA Lat/Lan in Degree, Minutes and Seconds j Cancel

Lon® |8 Lon' |33 Lon" |58.17
Lat® |47 7 Lat" |2.95

<

B b8 R [ ]| | RS- B BT

Figure 40: Calibrating a map using calibration tool (position 3)

Following these steps the map is now calibrated and can be used with u-center for visualizing road tests etc.

UBX-13005250 - RO6 Production Information u-center menus and windows
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4.2.9 Chart view

Chart view allows the user to conveniently view GNSS data records in graphical form. The data can be scaled in
many different ways and formats. It’s even possible to print the entire chart.

The examples below illustrate two different typical applications

Chart - [Alt (HAE) (m) / Index] = B

R - R A A N T TS I N T ~Jlme16 <Jfrone =]faemsn =]

Figure 41: Altitude as a function of Index (X = Index, Y = Alt)
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Chart - [Lat (%) / Lon (%]

bR

L)

I ‘*’ ¥1 [Lat - H"’r"?| j ch|’ Jl'e J|- M3

Figure 42: Latitude as a function of longitude (X =Longitude, Y = Latitude)

Function Description Toolbar icon
The position of the cursor is shown on the lower left edge of the
Cursor u-center screen (Longitude, Latitude and Pixel-Position). By
holding the left mouse button and moving the cursor over the
chart you can measure distance from one position to another
Move The chart inside the chart view window can be moved
Zo0om In Drawing a rectangle enlarges the chart to the new view. To zoom
in the chart double-click on the chart.
Drawing a rectangle decreases the chart to the new view. To
Zoom Out

zoom out the chart double-click on the chart.

Drawing Mode

The size and form of the displayed values can be changed in the
menu points; the connection line between the values can be
selected in the menu connect. For viewing the statically values
(average, minimum, maximum, standard deviation) directly in the
chart select the statistics menu

Fit Y range

Fits the Y range

Follow Y

Follow the most current Y value (the most current Y-value is
always in the middle of the chart)

Index or Y value

Switch between the index and the Y value

Y value Select the Y value to be displayed
Fit X range Fit the X range

Follow the most current X value (the most current X value is
Follow X

always in the middle of the chart)

Index or X value

Switch between the index and the X value

UBX-13005250 - RO6

Production Information

u-center menus and windows
Page 47 of 66




@blox

u-center - User Guide

X value

Select the X value to be displayed

R

Moving average

Adds a moving average. The average is calculated over the
number of most recent values, specified with the parameter.

Al |16 Jnone

Table 16: Description of the buttons and displays in Chart View

& The number of displayed epochs is set to 1800 by default (see also section 3.3).

UBX-13005250 - RO6
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4.2.10 Histogram view

Histogram views allow the user to view GNSS data and probability distributions (Figure 43) and print the entire
histogram if desired. The number of bins (storage containers) can be set by the user.

Histogram - [Alt (HAE) with 64 bins]

o[5S

....................... [ P R Ry PR
v v I

__________________________________________________________

_______________________________________________

m

.......................................

...................................

4 I 3
b R~ Lof T wnfaman -l -]
Figure 43: Altitude Histogram View
UBX-13005250 - RO6 Production Information u-center menus and windows
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Histogram - [Alt (HAE) with 64 bins]

o BOR|E v Lo T e e HAE

=[5 =]

Figure 44: Probability chart

The number of displayed epochs is set to 1800 by default (see also section 3.3).

Function Description Toolbar icon
The position of the cursor is shown on the lower left edge of the u-
center screen (Longitude, Latitude and Pixel-Position). By holding the

Cursor . _ B
left mouse button and moving the cursor over the histogram you can
measure distance from one position to another.

Move The histogram inside the histogram view window can be moved. &+

Zo0om In Drawing a rectangle enlarges the histogram to the new view. To &
zoom in the histogram double-click on the histogram.

Zoom Out Drawing a rectangle decreases the histogram to the new view. To &
zoom out the histogram double-click on the histogram.
The size and form of the displayed values can be changed in the
menu points; the connection line between the values can be selected

Drawing Mode in the menu connect. For viewing the statically values (average, -

minimum, maximum, standard deviation) directly in the histogram
select the statistics menu.

Probability

Displays the probability histogram (see Figure 40).

Fit Probability

Fit the Probability range.

i

Y value

Select the Y value to be displayed

At(HAE) =

Bins

The number of bins

G4 -

Table 17: Description of the buttons and displays in histogram view
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4.2.11 Camera view

The camera view function enables photographs, taken during recording of log files, to be linked to the GNSS
data stored in the corresponding log files. This allows a video depiction of the test, with a picture assigned to a
specific point of GNSS data.

“u u-center
Fe Edt Wew Flaysr Recsher Took Window el
DE&F- &5 L8 ]
- m sl —F W@
- A BODNO-E-B-M-BF A0SCE0 888

Gokn Poation 211513 | 94T bl & I i+ 00_poodante Lt o0:11:0 13Ere0 (8

Figure 45: Camera view

& Using Camera View can result in very large log files and can slow down u-center when playing such files.
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4.2.12 Deviation map
The deviation map displays positions in longitude and latitude relative to a defined reference position.

Deviation Map

B | H|l1 /vy xLCDM|acC

E=8 Eoh <)

Figure 46: Deviation Map

u-center - User Guide

Function Description Toolbar icon
The reference position can be defined as:
- The average of all previously measured positions
P i - The current position
roperties - Afixed, predefined value £
- The radius of the outer circle can be adjusted with the
Max. Deviation parameter.
Fit Automatically adjusts the reference position and the maximum i
deviation to fit all positions into the deviation map.
Track Show track of values from the internal database.
Statistics Show statistics of the values from the internal database. H
Maximum Shortcut for changing the scale of the deviation map to prefixed
deviation shortcut | values: M
. Shortcut for setting the reference position:
Reference position - A= average position A
shortcut gep .
- C = current position
Table 18: Description of the buttons and displays in Deviation Map
& The number of displayed epochs is set to 1800 by default (see section 3.3).
UBX-13005250 - RO6 Production Information u-center menus and windows
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Sky view is an excellent tool for analyzing the performance of antennas as well as the conditions of the satellite
observation environment. The polar plot graphically displays the averaged relative satellite signal strength (see
Figure 47), the position of satellites in the sky, identifies satellites by number and indicates which satellites are
being used in the receiver calculation (see section 3.1). Right-clicking the mouse on sky view allows the copying
of C/NO values in tabular form to another program.

[ Sy View

© OB D w5

[-o- |- ]

Figure 47: Sky view

Function Description Toolbar icon
Linear projection Displays the sky view with a linear projection.
Sine projection Displays the sky view with a sine projection.
C/NO Displays or hides the averaged C/NO values. i
Orbits Displays or hides the satellite orbits. =
Satellites Displays or hides the current satellite positions. Hi
Coordinates Displays or hides the caption for the azimuth. wie
Elevation Displays or hides the caption for the elevation. i

Table 19: Description of the toolbar in sky view
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5 Tools

This section will give an overview of the embedded tools of u-center. They can be used for different purpose and
should facilitate the usage of u-blox GNSS receivers.

The tools can be found under the ‘Tools’ menu but some of the options are only displayed when a receiver is
connected to u-center. The firmware update tools also depend on the connected receiver generation.

-
el COMB - u-center 8.01 I - — - =

File Edit View Player Receiver ITools] Window Help

= | = |ﬁ| & # Firrware Update Antaris ...
. ) Firmware Update u-blox 5/6/7/M&...
NE =

Dump Receiver Diagnostics...

Sl « [0 -

Trace download
AssistMow Offline...
u-blox 7/M8 Retrieve Log...
GM55 Configuration...

Preferences...

Figure 48: Tools menu entries

5.1.1 Firmware Update Antaris...
This tool is not described as the generation Antaris has been announced end-of-life.

5.1.2 Firmware Update u-blox 5/6/7/M8...

This tool will allow you to update the firmware of a receiver. This only works if your receiver has a flash memory
attached as the firmware has to be stored in this location.

Perform the following steps to update the firmware:
1) Establish the serial communication between u-center and the device (see also section 2.4).
2) Open firmware update tool by clicking on Tools = Firmware Update u-blox 5/6/7/M8...

u-blox 5/6/7/M8 Flash Firmware Update- [

Firmware image
e IEI: “Program Files (#86)hu-centerhUBLOX_ME_201.44561d1d5b1 dB¢ ;I _I
é Flash definition file [needed for generations 5 / 6]
| ‘ IIZ: WProgram Files [286]\u-centerflash. tat ;I _I

1

@ [V Use this Baudrate for update [ USE altemative update method
|115200 ﬂ v Enter Safeboot before update

IV Clear BER before update ¥ Send Training sequence

[ Pragram FIS only

Flazh Information Structure [FIS] file [needed for generations 7 / ME)
IC: “Program Files (x86)4u-centeriflash. xml ;I J

0K Cancel

e

Figure 49: u-blox 5 Firmware update window
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a) Select the firmware image suitable for the connected receiver.

b) Select the flash definition file (only needed before u-blox receiver generation 7). This file should be
provided bundled with u-center. Point to the latest file version.

c) Select the flash information structure file (only needed after and including u-blox receiver generation 7).
This file should be provided bundled with u-center. Point to the latest file version.

d) Select the correct options for your receiver:

Option Description Recommended

Use this Baudrate for update Selects the speed of the communication for | 115200
updating the firmware on the receiver.

Only has an effect when the receiver is connected
over a serial port.

Clear BBR before update Deletes the complete battery backed memory (BBR) | enabled
so that the receiver will start with the default
configuration.

Program FIS only Writes only the flash information structure (FIS) | disabled

into the external memory and does not update the
firmware. This option is used for receivers running
from ROM but with an attached SQI memory (for
example for logging).

Only supported after and including u-blox receiver
generation 7.

USB alternative update method | Erases the first sector of the flash memory and | disabled
restarts the receiver. The receiver will then start
from ROM and the flash firmware can be updated.

Use this method if you want to update the
firmware of a receiver connected over USB.

Enter Safeboot before update Sends the command to enter safeboot. In this | enabled
state, the receiver boots from the internal ring
oscillator and does not rely on any external
components. GNSS functionality is not started and
the receiver does not output any data.

Don’t use this method when having the receiver
connected over USB.

Send Training sequence Sends the training sequence after safeboot was | enabled
entered. This synchronizes the internal ring
oscillator so that a communication can be
established.

e) Click on “OK™.
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5.1.3 Dump receiver diagnostics

Dump Receiver Info to File I&

Iz this tool to dump diagnostic infarmation to a file if u-blox
support requests wou ta do 2o for additional info on a bug repart

Diagnostics output file:

C:hdiagnostic. ubs
Ok, | | Cancel |

Figure 50: Dump receiver diagnostics tool

This tool is used to dump the receiver diagnostic to a file. Use this tool if requested by the support team.

5.1.4 GNSS configuration

u-center is capable of getting the actual configuration of a u-blox GNSS positioning chip or module and storing
it to an ASCII text file containing hexadecimal records. Such a file can be edited and stored to a u-blox GNSS
device again. By clicking the menu “Tools -> GNSS Configuration...” of u-center, the GNSS Configuration dialog
opens. The following functions are available:

GMSS Configuration l&

Configuration file:

| Sl

[ Store configuration intaBEBR AFlash
[rion-volatile memany]

R etries [for every message): 'I_%l

GNSS > File | |

| Cloze |

Figure 51: GNSS configuration tool

- Specify the name of a new configuration file to store current configuration from the u-blox GNSS
device

- Specify the name of an existing configuration file and load this configuration into the u-blox GNSS
device

- Aflag can be set to force storing the configuration into the Battery Backed RAM (BBR) or Flash.
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5.1.4.1 Read/Write configuration files

1.
2.
3.

&

Connect to the device.
Open Tools / GNSS Configuration.

To read an existing configuration file, select the name of the file, then click on “File > GNSS” button. The
GNSS Configuration window then closes and the progress window pops up, showing the configuration
being sent to the receiver. This progress window closes after finishing the transfer without error.

Select “store configuration into BBR/Flash” checkbox if the parameters need to be stored into the device’s
non-volatile memory (BBR/Flash).

Sending a configuration to a u-blox GNSS device may fail due to a baud rate change on the current serial
port of the receiver to which the configuration is being sent. If this happens, simply change the u-center
baud rate and send the configuration again.

To write a new configuration file, click on “GNSS > File”. The GNSS Configuration window closes and the
progress window pops up, showing the configurations being polled and stored into a local file in ASCII format.

If reading or writing configuration data fails too frequently, try to increase the number of retries u-center should
do on a single message if one fails.

The user can abort the transfer by clicking the “Abort” button. It's not possible to close the window unless
transfer has completed or the user aborted it.

&

It is not recommended to read/write configuration while the u-blox GNSS device is in sleep mode.
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5.1.4.2 Editing configuration file

Mj configuration.txt - Notepad ; IEI&H“

File Edit Format View Help

CFG-M5G - 06 01 08 00 FO 06 00 00 00 00 00 00 -
CFG-Ms5G - 06 01 08 00 FO OF OO0 00 00 00 00 00

CFG-Ms5G - 06 01 08 00 FO 08 00 00 00 00 00 00

CFG-M5G - 06 01 08 00 FO 09 00 00 00 00 00 00

CFG-M5G - 06 01 08 00 FO OA OO0 00 0O OO0 00 00

CFG-M5G - 06 01 08 00 FO OD OO0 OO0 00 00 00 00

CFG-Ms5G - 06 01 08 00 FO OE OO0 0O 0O OO0 00 00

CFG-M5G - 06 01 08 00 FO OF Q0O 0O OO 00 00 00

CFG-M5G - 06 01 08 00 F1 00 QO 00 00 00 00 00

CFG-M5G - 06 01 08 00 F1 O3 0O 00 00 00 00 00

CFG-M5G - 06 01 08 00 F1 04 0O OO0 OO 00 00 00

CFG-NAVY - 06 24 24 00 FF FF 00 03 00 00 00 00 10 27 00 00 05 00 FA 00 FA 00 B4
CFG-NAVXS - 06 23 28 00 00 00 FF FF 1F OO0 00 00 02 02 03 14 06 00 00 01 00 00 DC
CFG-NMEA - 06 17 14 00 00 40 00 02 00 00 00 00 00 00 00 01 00 00 00 00 00 00 00
CFG-0DO - 06 1E 14 00 00 00 00 00 00 00 00 00 19 46 19 66 0a 22 00 00 99 4C 00 O
CFG-PM2 - 06 2B 2C 00 01 06 00 00 00 90 02 00 E& 03 00 00 10 27 00 00 00 00 00 O
CFG-PRT - 06 00 14 00 00 0O 00 00 B4 0O 0O 00 OO0 0O 00 00 OF 00 032 00 00 00 00 O
CFG-PRT - 06 00 14 00 O1 0O 00 OO0 CO 08 00 OO0 BO 25 00 00 OF OO O2 00 OO0 00 QO O
CFG-PRT - 06 00 14 00 02 00 00 00 CO 28 00 00 OO0 OO OO OO OO OO0 OO OO0 OO0 0D 00 O
CFG-PRT - 06 00 14 00 02 00 00 OO0 OO0 OO OO OO OO0 OO 0O 00 OF 00 O3 00 00 00 00 O
CFG-PRT - 06 00 14 00 04 0O OO0 00O OO OO0 0O 00 00 00 00 00 00 00 0D OO0 00 00 00 O
CFG-RATE - 06 08 06 00 EE 02 01 00 01 0O

CFG-RINY - 06 34 18 00 00 4E 6F 74 69 62 65 3A 20 6E 6F 20 64 61 74 61 20 73 61
CFG-RXM - 06 11 02 00 08 00

CFG-5BAS - 06 16 08 00 01 02 03 00 51 A2 06 00

CFG-TPS - 06 31 20 00 00 00 00 00 32 00 00 00 40 42 OF 00 40 42 OF 00 00 00 0O O
CFG-TPS - 06 31 20 00 01 00 00 00 32 00 00 00 04 00 Q0O OO0 O1 00 Q0O OO0 48 EB 01 O
CFG-USE - 06 1B 6C 00 46 15 AB 01 00 00 00 00 64 00 22 01 75 2D 62 ©C 6F 78 20 4!

m

Figure 52: Content Configuration File

When clicking the ““Edit” button in the GNSS Configuration dialog, the Notepad editor opens (standard
Windows software). Configurations are stored the following way:

- 1% line: it contains the version of the u-blox GNSS receiver where the configuration is from. Never
change this line!

- For the 2" line and following each line contains the same: <class ID>-<message ID> - <hexadecimal
byte code of the message>. The byte code consists of class and message IDs (2 bytes), payload
length (2 bytes), payload (payload length bytes). The sync characters and the checksum are not
included. They will be calculated automatically.

Refer to u-blox Receiver Description including Protocol Specification for detailed information and ranges.

5.1.5 Hotkeys

The Tools Menu allows administrating the Hotkeys defined in the Message View. Refer to section 4.2.4 for more
information on the Hotkeys.

5.1.6 Preferences
The preferences tool can be used to configure a number of u-center parameters.
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6 How To

6.1 Change baud rate of receiver

1) Connect to the device.
2) Open View / Messages View (Hotkey: F9).
3) Select UBX-CFG-PRT.

) . . E's
4)  Poll the current configuration from the receiver ( &= pl“”).

5) Change the setting to the desired baud rate.
6) Send the message to the receiver ( = Send)

Messages - UBX - CFG (Config) - PRT (Ports) =N IR

- CFG (Config) -

IIBX - CFG [Config) - PRT [Part
. AT (Antenna Settings, (Config) (Ports]

»

- CFG (Configuration)
- DAT (Datum)

- EKF (EKF Settings) Protocolin ~ |0+1+2 - IBX+NMEA+RT = |
- ESFGWT (Gyro+Wheelti

BN (i o Viode) Protocol aut |0+1 - LIBX+NME& |
- GMSS (GMSS config) |2 Baudiate
- HMR. (High Mav Rate)
- INF (InfMessages)

- ITFM (Jamming/Interfe
.. LIC (License) B7E00
. LOGFILTER (Log settingl 12133333
- M50 (Messages) AE0900
- MAY [Mavigation) 921600
- MAV2 (Mavigation 2)
- MAVS (Mavigation 5)

Target |1-UsRT1 |

m

- MAVXS (Mavigation Exp 0000 BS 62 06 00 14 00 01 00 00 00 we{fPQDIDT
.. NMEA (NMEA Protocol O0O0R DO O8 00 00 80 25 00 00 07 00 BIPfEERIIID
.. 000 (Odometer/Low-¢ 0014 O3 00 00 QOO0 00 00 A2 BS P en

- PM (Power Manageme
. PM2 (Extended Power b
.. PRT (Ports)

. PWR (Power)

... RATF (Ratecl

(I FRS—T— b
& | X | Esend 3ZPoll [5¥ | &

-~

Figure 53: Changing baudrate (using UBX-CFG-PRT)
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6.2 Save parameters to receiver non-volatile memory (BBR/Flash)

There are 2 ways to save parameters to the receiver’s non-volatile memory (BBR/Flash).

6.2.1 Saving parameters with UBX-CFG-CFG
1) Connect to the device.

) Open View / Messages View (Hotkey: F9).
3) Select UBX-CFG-CFG.

) Select ““save current configuration™ (see Figure 54).

N

N

5) Send the message to the receiver ( = Send)
Messages - UBX - CFG (Config) - CFG (Configuration) o= (3]
B CFGA'S; ?zaienna et “ | uBx - CFB [Config) - CFG (Corfiguration) el
CEG ltCanlguratmn] b ™ Revert to last saved configuration
- DAT (Datum) i ]
... EKF (EKF Settings) " Revert all but ANT default configuration
- ESFGWT (Gyro+ Wheetti i .Hevert to default u:u:unfigurgtil:nn > [2C-EEPROM
. FXN (Fix Now Mode) @ Save curent configuration 4- SPLFLASH l
. GMSS (GMSS config)  |= " User defined operation
- HMR {High Mav Rate) Clear Save Load
- INF (InfMessages) 0-FRT - 0-PRT -
- ITFM (Jamming/Interfe 12 ITJSFG b 12 ITJSFG b
.. LIC (License) 3. My 3. My
-. LOGFILTER (Log settingLl | |4 - RxM £ 4 - R = i
MG (Messages i i
- NAV (Navigation] 7 - Unused 7 - Unused
. NAV2 (Navigation 2) 3 - Unuzed 3 - Unuzed
. NAVS (Navigation 5) S 3R -
.. NAVXS (Navigation Exp D000 BS5 &2 06 09 OD 00 0D 00 00 00 ubdddPdddd -
. MMEA (NMEA Protocol Qgook FF FF 00 00 00 00 00 00 03 1D #9l8d3808d37d
- OD0 (Odometer/Low-£ 0014 AB =
- PM (Power Managemel
.. PM2 (BExtended Power b
.. PRT (Ports)
. PWWR (Power)
__RATF (Ratec) i
' 1 b -
& | X | Esend i¥ron [ | #

Figure 54: Saving Parameters (using UBX-CFG-CFG)

6.2.2 Saving parameters with GNSS configuration
Refer to 5.1.4.1 step 3

6.3 Recording/playing a log file

u-center allows recording and playing log files. Use the player controls, to record or playback a log file. Select the
log file to be opened through the file menu tool bar. The series of buttons in the player toolbar can be used to
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navigate through the log file. The records will be displayed on the navigation display window, in the same way
that live GNSS data is displayed when using u-center.

6.4 Conduct sensitivity tests

u-center is a useful tool for conducting sensitivity tests of GNSS positioning chips and modules and receiver
designs. To do so, under open sky conditions record a log file of the receiver to be tested and an Evaluation Kit
as reference. Make sure that the log files are recorded under the same conditions. Using the Statistic View or
Table View windows from u-center, compare the C/NO values of the five strongest satellites. With Table view,
export the values to a spreadsheet for analysis.

6.5 Read/write configuration files
Refer to 5.1.4.1.

6.6 Set GNSS system configuration

Connect to the device.

Open View / Messages View (Hotkey: F9).

Select UBX-CFG-GNSS.

Place or remove the checkmark for the desired GNSS under “enable”.

Send the message to the receiver ( 5=]5end),

The following Figure 55 shows an example that configures the device to receive only GLONASS.
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Messages - UBX - CFG (Config) - GMNSS (GNS5 config)

-

(o[ ]

B CFG (Config) -

LB - CFG [Config) - GMNSS [GHSS config)

-

. AT (Antenna Settings,
- CFG (Configuration)
-~ DAT (Datum) GNSSID confi GNSS b ChamEls Signal
. EKF (EKF Settings) configure name enable min  max ignals
. ESFGWT (Gyro+Wheelt| | | 0 4 GPS r [s [
. FEM (Fixx Mow Mode) 1 v SBAS I~ I 1 |3
-. GMSS [GMSS config)  |= I—
. HNR (High Nav Ragtey - a clieo [0 o =
. INF (InfMessages) 3 W BeiDou r I 8 I 16
- [TFM (Jamming/Interfe 4 r IMES = I ] ||:|
- LIC {License]
( = [o |3
. LOGFILTER (Log setting_ | 3 v Q55 a
. MSG (Messages) 6 v GLoMass W |B |1"r
- MAV (Mavigation)
- NAVZ (Navigation 2} Mumber of channels available I 32 e
. WLAVS (Mavigation 5 I_
F,k : ,a IE!E “:tn : Mumber of channels to use 32 I Auto set
- MAVKS (Mavigation Exp
- NMEA (NMEA Protocol For specific SBAS configuration use CFG-SBAS
.. 000 (Odometer/Low-¢ i
- PM (Power Managemel .| il | a
.. PM2 (Bxtended Power b Qo000 B5 62 06 3E 2C 00 00 00 20 05 pbd>, 0400 1 -
. PRT (Ports) DODZA 00 O 10 00 00 00 01 01 01 01 JPJIPFPP377 i
. PWR (Power) 0014 03 00 00 00 01 01 03 08 10 00 Q3PP Q0807 3
 BATE (Ratect -~ |001E 00 00 01 01 05 00 03 00 00 00 JQ&Q989384d
4 | T b 0028 01 01 06 O8 OE OO0 01 00 01 01 JRAPQPQpR08707 -

@ | X | ESend Pl [¥ | @

Figure 55: GNSS configuration (using UBX-CFG-GNSS)

6.7 Activating PPP (EVK-6PPP only)

W N P

)
)
)
)

o b

)

UBX-13005250 - RO6

Connect to the device.

Open View / Message View.

Select UBX-CFG-NAVX5 window.

Place or remove the checkmark for ““Use PPP”’,

Send the message to the receiver ( £5 Send)
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Messages - UBX - CFG (Config) - NAVXS (Navigation Expert 5)

(o[ ]

- CFG (Confi - -

B LFG [Lonfig) 7| UBX-CFG (Config) - NAYXS [Navigation Expert 5] i
- AMT (Antenna Settings]
CliG |:Ccnf|gurat|cn] — Mavigation nput Filkers
- DAT (Daturn)
. EKF (EKF Settings) indhd an 54z I 3 I 20 [#]
- ESFGWT (Gyro+Wheelti .

L ki CAMO I B [dbHz]
. FXM (Fixx Mow Mode)
. GMSS (GMSS config) |2 [ Iritial Fix must be 20
- HMR. (High Mav Rate)
- INF (InfMessages) - Mizcellaneous =
- [TFM (Jarmming/Interfe GPS week rollover I 1756
- LIC (License) [0 = firrmware default)
- LOGFILTER (Log settingl—
- M5G (Messages)
- NAV (Navigation) — AzzistM ow Autonomous
- WAVZ (Mavigation 2
':t. I: i !Elﬂ !Cn ] [T Usze szsisthow Autonomous
- MAVS (Mavigation 5) H tabi
L aw. acceptable I
- e R [modelled) orbit erar 1o [ml R
. NMEA (MMEA Protocol [uge "0" to revert to the firrmsare default]
.. QD0 (Odometer/Low-£ ~ Mizcellaneous
- PM (Power Managemel | Y T VU S S CH P | S
.. PM2 (Extended Power b 0000 BS 62 06 23 28 00 00 00 4C &6 pbl#(fIJLE -
.. PRT (Ports) DOOR 00 00 00 00 00 00 03 14 06 00 J222302202
. PWR (Power) 0014 00 00 00 00 DC 06 00 00 00 00 J3PFUIIIET
 RATE (Batec) ~ |001E 00 00 01 00 00 00 &4 00 00 00 JQJ00389dfdd
< T b 0028 00 00 00 OO0 00 00 &7 21 Irprig! -
@ | X | Esend FPoll | 5% | &
Figure 56: How to activate and deactivate PPP using UBX-CFG-NAVX5
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7 Troubleshooting

NMEA or UBX protocol is not available in the Messages View

u-center uses dynamic link libraries (DLL). The installation program will automatically install the required DLL’s
into the u-center program directory. Should you try to copy a u-center installation from one location to another,
make sure you also copy the DLL files. Verify, the version of u-center matches the DLL version.

u-center doesn’t display all messages

Make sure the baud rate is sufficient. If the bandwidth is insufficient, receivers based on the ANTARIS™
Technology will skip excessive messages.

Some serial port cards/adapters (i.e. USB to RS232 converter) frequently generate errors. If a communication
error occurs during while u-center receives a message, the message will be discarded.

u-center loses the connection to the device

u-blox GNSS positioning chips and modules have an autobauding feature. If frequent communication errors
occur (i.e. due to problems with the serial port), the connection may be lost as u-center and the device will
autonomously try to adjust the baud rate. Do not enable the u-center autobauding feature if the device has the
autobauding enabled.

Some COM port are not shown in the port list

Only the COM ports that are available on your computer will show up in the COM port drop down list. If a COM
port is grayed out, another application in the computer is using it.

PC is very slow when u-center runs

If a high value of epochs is selected, the display in real-time cannot be guaranteed, especially when many
graphical views are open. u-center does not update minimized views and console in real-time. Close or minimize
as many of the graphical views and consoles as possible and u-center will run faster.

Log file / Data are only partly displayed

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of larger logfiles. The
limitation is set to 1800 epochs by default. That means if an epoch is available every second you can analyze
data for as much as 30 minutes. After this time the oldest values are discarded. Data stored to a log file are not
affected by the database limitation. Refer to section 3.3 for instructions on how to increase this limit.

When planning long-term observations, it’s recommended to start recording a log file before analysis begins.

Output messages are not updated in the Messages View

Make sure that the protocol you would like to receive is enabled. If so, double-click on the desired output
message. Double-clicking on an output message enables or disables the periodic message update if the
respective protocol is active. Alternatively, select the desired input or output message and press the ‘Poll’ button.
If you would like to get UBX-INF () messages in the log file, configure the receiver accordingly with the
UBX-CFG-INF input message.

No logfile is recorded

After a new lodfile is created, logging will not automatically start but only after selecting the Record button in
the Player Toolbar.
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Related documents

[1] GPS Compendium, Doc No GPS-X-02007
[2] u-blox 5 Receiver Description including Protocol Specification, Docu. No GPS.G5-X-07036
[3] u-blox 6 Receiver Description including Protocol Specification, Docu. No GPS.G6-SW-10018
[4] u-blox 7 Receiver Description including Protocol Specification V14, Docu. No GPS.G7-SW-12001
[5] u-blox M8 Receiver Description including Protocol Specification V15, Docu. No UBX-13003221
& For regular updates to u-blox documentation and to receive product change notifications, register on our
homepage.

Revision history

Revision Date Name Status / Comments
- 08-Oct-2008 tgri Initial release
A 22-Jul-2009 tgri New ClI
Al 17-Feb-2011 tgri Third party libraries
B 1-Nov-2011 tgri Google Earth View added
C 03-Jun-2012 khir Updated for u-center 6.3. GNSS configuration added
Last revision with document number GPS-SW-08007
RO6 09-Dec-2013 maba Update for u-center 8.01 and u-blox 7 and M8 generations
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Contact

For complete contact information visit us at www.u-blox.com

Offices

North, Central and South America

u-blox America, Inc.

Phone: +1 703 483 3180
E-mail: info_us@u-blox.com

Regional Office West Coast:

Phone: +1 703 483 3184
E-mail: info_us@u-blox.com

Technical Support:

Phone: +1 703 483 3185
E-mail: support_us@u-blox.com

UBX-13005250 - RO6

Headquarters
Europe, Middle East, Africa

u-blox AG

Phone: +41 44 722 74 44
E-mail: info@u-blox.com
Support:  support@u-blox.com
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Asia, Australia, Pacific

u-blox Singapore Pte. Ltd.

Phone: +65 6734 3811

E-mail: info_ap@u-blox.com
Support:  support_ap@u-blox.com

Regional Office Australia:

Phone: +61 2 8448 2016
E-mail: info_anz@u-blox.com
Support:  support_ap@u-blox.com

Regional Office China (Beijing):
Phone: +86 10 68 133 545
E-mail: info_cn@u-blox.com
Support:  support_cn@u-blox.com

Regional Office China (Shenzhen):

Phone: +86 755 8627 1083
E-mail: info_cn@u-blox.com
Support:  support_cn@u-blox.com

Regional Office India:

Phone: +91 959 1302 450
E-mail: info_in@u-blox.com
Support:  support_in@u-blox.com

Regional Office Japan:

Phone: +81 3 5775 3850
E-mail: info_jp@u-blox.com
Support:  support_jp@u-blox.com

Regional Office Korea:

Phone: +82 2 542 0861

E-mail: info_kr@u-blox.com
Support:  support_kr@u-blox.com

Regional Office Taiwan:

Phone: +886 2 2657 1090
E-mail: info_tw@u-blox.com
Support:  support_tw@u-blox.com

Contact
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